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Introduction

INTRODUCTION

The National Council for Curriculum and Assessment (NaCCA) has developed a new Senior High 
School (SHS), Senior High Technical School (SHTS) and Science, Technology, Engineering and 
Mathematics (STEM) Curriculum. It aims to ensure that all learners achieve their potential by equipping 
them with 21st Century skills, competencies, character qualities and shared Ghanaian values. This will 
prepare learners to live a responsible adult life, further their education and enter the world of work.

This is the first time that Ghana has developed an SHS Curriculum which focuses on national values, 
attempting to educate a generation of Ghanaian youth who are proud of our country and can contribute 
effectively to its development.

This Teacher Manual for Information Communcation Technology covers all aspects of the content, 
pedagogy, teaching and learning resources and assessment required to effectively teach Year One 
of the new curriculum. It contains this information for the first 12 weeks of Year One, with the 
remaining 12 weeks contained within Book Two. Teachers are therefore to use this Teacher Manual 
to develop their weekly Learning Plans as required by Ghana Education Service.

Some of the key features of the new curriculum are set out below.

Learner-Centred Curriculum
The SHS, SHTS, and STEM curriculum places the learner at the center of teaching and learning by 
building on their existing life experiences, knowledge and understanding. Learners are actively 
involved in the knowledge-creation process, with the teacher acting as a facilitator. This involves 
using interactive and practical teaching and learning methods, as well as the learner’s environment 
to make learning exciting and relatable. As an example, the new curriculum focuses on Ghanaian 
culture, Ghanaian history, and Ghanaian geography so that learners first understand their home and 
surroundings before extending their knowledge globally.

Promoting Ghanaian Values
Shared Ghanaian values have been integrated into the curriculum to ensure that all young people 
understand what it means to be a responsible Ghanaian citizen. These values include truth, integrity, 
diversity, equity, self-directed learning, self-confidence, adaptability and resourcefulness, leadership 
and responsible citizenship.

Integrating 21st Century Skills and Competencies
The SHS, SHTS, and STEM curriculum integrates 21st Century skills and competencies. These are:

•	 Foundational Knowledge: Literacy, Numeracy, Scientific Literacy, Information Communication 
and Digital Literacy, Financial Literacy and Entrepreneurship, Cultural Identity, Civic Literacy 
and Global Citizenship

•	 Competencies: Critical Thinking and Problem Solving, Innovation and Creativity, Collaboration 
and Communication

•	 Character Qualities: Discipline and Integrity, Self-Directed Learning, Self-Confidence, 
Adaptability and Resourcefulness, Leadership and Responsible Citizenship

Balanced Approach to Assessment - not just Final External Examinations
The SHS, SHTS, and STEM curriculum promotes a balanced approach to assessment. It encourages 
varied and differentiated assessments such as project work, practical demonstration, performance 
assessment, skills-based assessment, class exercises, portfolios as well as end-of-term examinations 
and final external assessment examinations. Two levels of assessment are used. These are:
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•	 Internal Assessment (30%) – Comprises formative (portfolios, performance and project work) 
and summative (end-of-term examinations) which will be recorded in a school-based transcript.

•	 External Assessment (70%) – Comprehensive summative assessment will be conducted by the 
West African Examinations Council (WAEC) through the WASSCE. The questions posed by 
WAEC will test critical thinking, communication and problem solving as well as knowledge, 
understanding and factual recall.

The split of external and internal assessment will remain at 70/30 as is currently the case. However, 
there will be far greater transparency and quality assurance of the 30% of marks which are school-
based. This will be achieved through the introduction of a school-based transcript, setting out all 
marks which learners achieve from SHS 1 to SHS 3. This transcript will be presented to universities 
alongside the WASSCE certificate for tertiary admissions.

An Inclusive and Responsive Curriculum
The SHS, SHTS, and STEM curriculum ensures no learner is left behind, and this is achieved through 
the following:

•	 Addressing the needs of all learners, including those requiring additional support or with special 
needs. The SHS, SHTS, and STEM curriculum includes learners with disabilities by adapting 
teaching and learning materials into accessible formats through technology and other measures 
to meet the needs of learners with disabilities.

•	 Incorporating strategies and measures, such as differentiation and adaptative pedagogies 
ensuring equitable access to resources and opportunities for all learners.

•	 Challenging traditional gender, cultural, or social stereotypes and encouraging all learners to 
achieve their true potential.

•	 Making provision for the needs of gifted and talented learners in schools.

Social and Emotional Learning
Social and emotional learning skills have also been integrated into the curriculum to help learners to 
develop and acquire skills, attitudes, and knowledge essential for understanding and managing their 
emotions, building healthy relationships and making responsible decisions.

Philosophy and vision for each subject
Each subject now has its own philosophy and vision, which sets out why the subject is being taught 
and how it will contribute to national development. The Philosophy and Vision for Information and 
Communication Technology is:

Philosophy: The next generation of ethical digital literates can be empowered through observation, 
curiosity, and exposure to related computing concepts and tools that leverage practical activities in a 
learner-centered environment leading to global and local relevance.

Vision: To prepare learners with 21st Century Skills and Competencies to ethically use and apply 
computing systems to solve real-world problems for economic development.
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SCOPE AND SEQUENCE

Information and Communications Technology Summary 

S/N STRAND SUB-STRAND YEAR 1 YEAR 2 YEAR 3
CS LO LI CS LO LI CS LO LI

1.
2.
3.

ICTs In the 
Society

Organising, Managing 
and Presenting 
Information Using 
Essential Productivity 
Tools

1 1 5 1 1 5 1 1 4

Emerging Technologies 
and Applications

1 1 3 1 1 2 1 1 2

Connecting And 
Communicating Online

1 1 2 1 1 2 1 1 2

4. Network 
Systems for 
Transmitting 
Information

Guided And Unguided 
Network Systems

1 1 2 1 1 2 1 1 1

Data And Information 
Security

1 1 3 1 1 2 1 1 2

Total 5 5 15 5 5 13 5 5 11

Overall Totals (SHS 1 – 3)

Content Standards 15
Learning Outcomes 15
Learning Indicators 39
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SECTION 1: MULTIMEDIA TOOLS AND APPLICATIONS

Strand 1: ICTs in the Society

Sub-Strand 1: Organising, Managing and Presenting Information Using Essential Productivity 
Tools

Content Standard: Demonstrate knowledge and understanding of the use of various computing 
tools to responsibly create multimedia documents containing text, images etc. e.g., birthday 
cards/Flyers for a specified purpose.

Learning Outcome: Create multimedia documents using appropriate computing tools

INTRODUCTION AND SUMMARY OF SECTION
This section focuses on equipping learners with the computing knowledge and skills to organise, 
manage and present information. With teacher guidance and support over these six weeks of lessons, 
learners will develop a better understanding of the relationship between the hardware and software 
components of a computer system, and how these components can be used in the creation of multimedia 
documents (i.e. a document with at least two types of media, such as text and graphics).

By the end of this section, the learner should be able to describe the software and hardware needed 
to create a multimedia document such as a poster or flyer. Also by the end of Section 1, learners 
should be able to demonstrate the use of the main features of both word processing and presentation 
applications in the development of multimedia documents.

This manual gives guidance on how to use the word processor, MS Word and the presentation program, 
MS PowerPoint. Teachers may wish to use different software that provides the same functionality. 
The main input and output hardware required will be a keyboard and mouse, and a screen/monitor 
respectively. Input/output may be via a touchscreen with onscreen keyboard. If learners are using 
tablets for word processing, a wired or wireless keyboard is advised. Some adaption of the guidance 
from that given in the manual (for a desktop computer and Office 365 applications) will be required 
if learners are using different versions of hardware and software. For example, the onscreen keyboard 
on an iPad has no Command button. Copy/Cut is achieved via tap and hold or tap and draw over for 
selection of entered text. When you lift your finger, you will see on screen controls for Copy and Cut.

The standalone version of Office Home and Student for Mac is only for Mac, and cannot be used on 
an iPad. Microsoft Word for iPad is available as part of the Office 365 suite on the App Store. You 
will need an Apple ID and Wi-Fi or cellular data connection access to download it onto your iPad. 
Once downloaded, tap the app to install it on your tablet like any other app. You can download the 
free Office apps from the iPad’s App Store, but without the subscription you will only be able to view 
documents only.

An outline of the work covered in this six-week section
Week 1: Describe the basic hardware and software needed to create a multimedia document

Week 2: Basic file handling, editing and reviewing tools in Word

Week 3: Formatting, table and picture tools in Word

Week 4: Basic layout tools for lines, paragraphs and pages in Word, including page layout, alignment, 
headers and footers, and page columns
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Week 5: Creating and editing lists, and using the styles tools in Word

Week 6: Creating slides consisting of text and graphics in PowerPoint

SUMMARY OF PEDAGOGY
This section considers a variety of activities, most frequently hands-on activities where learners 
engage in practical activities to create multimedia documents using word processing and presentation 
software (MS Word and MS PowerPoint). Learners should have opportunities to work in groups to 
develop solutions to assigned tasks. Vary the groupings throughout the six weeks considering mixed 
ability, similar ability, and mixed gender. In summary, individual and experiential practical learning 
activities should dominate the lessons on how to use word processing and presentation software. 
Practise is essential in learning any new skill!

Teacher instruction and demonstration followed by practical sessions, is a well-tested and effective 
strategy in the teaching of ICT. Although it will be the most commonly used format of the lessons in 
weeks 2 to 6, other teaching strategies also have a place. Brainstorm, brain write and discuss would 
fit well in the week 1 lessons and could be used when introducing topics or during plenary sessions. 
Videos and animations on key concepts can help link these concepts to real-life examples. Allowing 
learners to touch and feel hardware components (such as an old motherboard) in week 1 can make the 
study of computer systems less theoretical.

All learners, irrespective of their learning abilities, should be encouraged to participate fully in lessons. 
Offer below average/approaching proficiency learners the opportunity to make oral presentations on 
how to use an application feature when creating a multimedia document. Have a set of tasks on hand 
to challenge the highly proficient learners. Facilitate personalisation of activities where possible, and 
include where learners have autonomy over the design and content of the documents being created. 
One example is the activity to create a personal study timetable in Word with a learner’s photo added 
to the top of the document. This manual contains a variety of ideas for other practical activities. 
Learners should be given time and opportunities for the assimilation of new knowledge and skills. 
Examples include presenting to the class, contributing to class discussions, drawing concept maps, 
and creating user guides for certain application tools. An important role of the ICT teacher is to help 
develop learners’ confidence and independence when using computing tools. Guidance notes and 
eManuals/ paper-based manuals on the word processing and presentation applications being used 
should be made accessible to learners to refer to when they encounter a problem/forget a step.

SUMMARY OF ASSESSMENT
The assessment (formative and summative) section takes into consideration all the four levels 
in the Revised Bloom’s Taxonomy. Level 1(Recall/Reproduction), Level 2 (Skills/Conceptual 
understanding), Level 3 (Strategic Thinking/ Reasoning), and Level 4 (Extended Critical Thinking 
and Reasoning). All learners are considered in the assessment suggestions—learners approaching 
proficiency (AP), proficient (P) learners and highly proficient (HP) learners. Apart from the traditional 
form of practical and written tests and assignments, assessment in this section may include other 
forms. These include: concept maps, multiple-choice quizzes, group projects, self-assessments, oral 
presentations, peer review, portfolios, debates, game-based assessments, and digital storytelling.
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Week 1
Learning Indicator: 	Describe software, hardware, and other computing features needed to create 
a document.

Theme/Focal Areas: 
1. 	 Computer hardware needed to create a document.
2. 	 Computer software needed to create a document.

What is a Computer?
A computer is an electronic device that is designed to process data stored in its memory. The term 
computer is derived from the Latin term ‘computare’, which means to calculate or a programmable 
machine. A computer cannot do anything without a program (i.e. a set of instructions).

Figure 1.1: A desktop computer

A computer has the ability to accept data (input), process the data, and then output the results. A 
computer has many uses. These include: word processing, graphic design, gaming, teaching using 
slideshows, bookkeeping, as well as surfing the internet.

Computer Hardware Basics
Hardware: It is any physical device or component used in or with a computer system. Hardware can 
be classified as external or internal.

External hardware devices (peripherals): They are hardware devices located outside the computer. 
These include input, output, processing, storage, and communication devices. The first four types are 
regularly involved in the creation of the documents. Sometimes communications devices can also be 
used in the creation of documents if, for example, a network such as the internet is used in the creation 
of the document (like google docs).
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Peripherals are connected to the computer system with cables using a special connection socket 
called a port (for example, a USB port) or using a wireless connection (wi-fi or Bluetooth).

Input device

Figure 1.2: Examples of input devices

An input device is a hardware device which is used to enter data into a computer for processing. 
Examples are shown in Figure 1.2.

Some examples of input include:
•	 Words written using a keyboard
•	 Screen clicks using a touchscreen
•	 Live video from a webcam
•	 Sound from someone using a microphone for voice control
•	 Movement in front of a motion sensor in an automatic door

Someone using a computer to create a poster in Word would use a keyboard and mouse to enter and 
manipulate text. A scanner could be used to enter and input a photograph for use in a poster.

Output device
An output device is a hardware device that receives information from a computer and presents it in 
a human understandable form. Examples include: monitor, printer, scanner, speaker, touchscreen, 
projector, and headphones.

Some examples of output include:
•	 Sound coming from a mobile phone speaker
•	 Text appearing on a laptop screen or 

computer monitor
•	 Pictures printed from a printer
•	 Video shown on a tablet screen
•	 Movement from a motor when an 

automatic door opens

Figure 1.3: Examples of output devices
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When creating a poster using a desktop computer, a user would use the monitor to see the text and 
images as they are being entered and manipulated. A printer would be used to get a hard copy of the 
final poster.

Note that some devices such as a touchscreen can be classified as both an input and output device. A 
touchscreen on a tablet sends data to the tablet’s processor as you press different areas of the screen. 
Output such as an image or a video will be displayed on the screen.

Storage device
A computer storage device is a device that stores data and information. While working a computing 
task such as word processing a document, the WP program and the document file will be stored in 
RAM (an example of internal hardware). The program and your work in RAM will be lost the moment 
the computer is switched off. So, before switching off your computer, any work should be saved to 
secondary storage such as a hard drive. Secondary storage is a long-term storage that is used to keep 
programs and data indefinitely. Some examples of secondary storage devices and media are shown 
in Figure 1.4.

Figure 1.4: Examples of secondary storage devices and media

There are many forms of secondary storage and each type of secondary storage device has its own 
characteristics. Because all devices are different, some are more suited to certain applications than 
others. For example, a hard disk drive has a high capacity and reasonable access speed, making it 
suitable for everyday storage of programs and data. A USB pen drive (sometimes called a USB Flash 
drive or memory stick) is smaller in capacity, but extremely fast and portable, making it suitable for 
transferring files between computers.

Some secondary storage devices can be internal or external. The internal hard drive in your school’s 
computer could be used to store a poster you have produced in a lesson and an external hard disk drive 
or USB pen drive could be used to take the poster file home with you.

Cloud storage is now very popular as a means of storing computer files. Cloud storage refers to 
storing data on remote servers (computers responsible for storage and management of a large number 
of files) in data centres that is accessed through the internet. It offers flexible and scalable storage 
solutions with the convenience of accessing data from anywhere with an internet connection. So, if 
you saved your poster file in the cloud at school, you could easily access it from home without the 
need to physically transfer the file. Communication hardware devices such as a modem and router 
could be used to set up internet access at home.
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Internal hardware devices or components: They are any hardware that is located inside the 
computer. Examples include CPU: (Central Processing Unit), internal hard disk drive, ROM (Read 
Only Memory), and RAM (Random Access Memory).

Figure 1.5: Examples of internal hardware

A brief description of the functions of some of the main internal hardware items:

CPU (Central Processing Unit or processor) is the ‘brain’ of the computer where all the processing 
such as executing program instructions is done.

RAM (Random Access Memory) is the internal working memory of a computer where the programs 
and data that it currently uses are stored.

NIC (network Interface Card) is the hardware that enables a computer to connect to a network. A 
computer network is two or more computers connected together via wires or wirelessly. NICs exist to 
support various networking technologies such as Ethernet, Wi-Fi, Bluetooth and cellular connectivity.

Sound card is hardware that is responsible for handling sound received via a microphone and for 
producing sound on a computer that can be heard through speakers.

Graphics card/video card is hardware which is responsible for displaying images, videos, and 
animations on a computer screen/monitor.

Motherboard is a large circuit board that holds and connects all the essential components of a 
computer, allowing them to work together.

Figure 1.6: Motherboards – empty and with components
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All these items would also be considered to be processing hardware, that is, they are responsible for 
the processing of data within the computer system.

A multimedia document is a document with two or more types of media, including text, images, video, 
animation or sound. If you are creating a multimedia document such as a poster or a slideshow, then:

• the CPU would run the required program (such as Word or PowerPoint)
• RAM would store the Word or PowerPoint program as it is running. and your work
• a NIC would enable you to save your work on network storage
• a sound card would enable you to hear audio output from your slideshow
• a graphics card would enable video and graphics on your screen/monitor

Putting it all together

As explained above, the motherboard connects the various types of hardware to make a computer system.

The block diagram in Figure 1.7 shows how data fl ows between the main hardware components.

Figure 1.7: Block diagram of a computer system

Computer Software Basics

Software: It is programs/sets of instructions that tells a computer what to do or how to perform 
a specifi c task. Computer software runs on hardware. There are two main categories of computer 
software; application software and systems software.

Application software: These are programs designed to carry out a specifi c task other than one 
relating to the operation of the computer/device itself. Examples of application software include: a 
spreadsheet program, a database management system, a word processor, and a games program. A 
computer used to control a machine in a factory will run different applications software from that 
found in an offi ce used by an accountant for his/her work.

System software: These are computer programs designed to run a computer’s hardware and 
application software, and make the computer system available for use.
The main types of systems software are operating systems, device drivers, and utility programs.

• Operating System (OS): It is the software that lies between the applications software and the 
computer hardware as shown in Figure 1.8. It is the main system software and a computer will not 
function without it.
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Figure 1.8: The OS links the application /user to the hardware

The Main functions of an Operating System are
booting the computer, managing the computer’s resources 
(including the allocation of CPU, memory, storage devices, 
and printers), managing fi les, handling input and output, 
and executing and providing services for application 
software. The OS also provides the user with the ability to 
interact with the computer such as managing the display of 
icons on the desktop icon and reacting when a user double 
clicks on an icon.

As indicated in Figure 1.9, examples of operating 
systems include: Microsoft Windows, macOS, Linux, 
Android, and iOS.

• Device Driver: It is a program that is designed to control a particular hardware device that is 
attached to a computer. The main purpose of device drivers is to act as a translator between 
the hardware device and operating systems or applications that use it. It instructs the computer 
on how to communicate with the device by translating the operating system’s instructions into 
a language that a device can understand in order to perform the necessary task. Examples of 
device drivers are a printer driver, a display driver, a USB driver. A sound card driver, and a 
motherboard driver. Note that a modern OS will have built-in drivers for common USB devices 
such as mice and keyboards,

• Utility software: It is a program that helps set up, analyse, confi gure, improve, and maintain a 
computer system. Examples of utility software are antivirus programs, backup programs, and 
disk cleanup tools. Backup programs create a second copy of fi les which are stored separate 
from the original in case copies in case of loss or damage.

In conclusion, a computer system needs both hardware and software to function properly. Hardware 
needs software to tell it what to do, but software also needs hardware in order to act out its directions. 
As you have seen from these notes, for a user to create a document on a computer system, a variety 
of hardware and software are needed. The user will also need the knowledge and skills of how to use 
the hardware and software required. The guidance notes and tasks in Weeks 2 to 6 will help learners 
develop these valuable skills which can be used to create multimedia documents.

Learning Tasks

Here are some tasks/activities to help learners know and understand the basics of computer 
hardware and software and how they relate.

The teacher should differentiate the tasks to suit the profi ciency levels of the different learners.

Figure 1.9: Some OS examples
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The teacher should start the lesson by grouping learners, taking into consideration GESI and 
SEL, and have an open class discussions where learners brainstorm on what is meant by a 
computer system.

1. In pairs/small groups:

• Learners should individually think-write-share with their group members the defi nition 
of computer, hardware, and software, and agree on one defi nition for each. Each group 
should then give their defi nitions to the class.

• Learners brainstorm together on at least ten applications of computers in everyday life. 
Afterwards, each group should share the applications identifi ed with the class using 
tell-it-all.

• Discuss the categories of hardware and software components with examples and 
present the results with the class. The teacher can use these presentations to reinforce 
the relationship between hardware and software components.

• The teacher should select ten of the computer applications identifi ed earlier by the 
groups. Each group will then work together to list possible application software, and 
input, output, and secondary storage devices required for these applications. Each 
group should feedback their list for at least one of the applications.

• Patch images of hardware with given descriptions distributed by the teacher. There 
should be some surplus (bogus) descriptions included.

• Play hangman, where learners in the group take turns to select a hardware or software 
related word for the others to guess.

2. Individually, learners should complete worksheets containing questions relating to the focal 
areas such as:

A teacher creates a slideshow using a variety of computer hardware including a microphone. 
The slideshow contains text, images, background music and two videos. The slideshow is 
saved on a school computer.

a. Name the type of application software that the teacher would need to create the 
slideshow.

b. Why would the set of slides produced be considered a multimedia document?

c. Identify one way that the teacher can get access to the slideshow from his/her home 
computer.

d. Describe one reason the teacher used a microphone for this task.

e. List the hardware devices that the teacher’s students will need to interact with this 
slideshow on their comp uters.

Pedagogical Exemplars
These examples are only to serve as a guide to the teacher.

Starter: As this is the start of a new course, the teacher can start the lesson by using “Into-Tag “, 
where the teacher and learners write their names on a piece of paper tape and stick on their shirt or 
dress respectively.

Scan this QR code for more information on how Intro-Tag is used:
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Direct instruction: The teacher goes through the key hardware and software concepts, showing 
images of both internal and external hardware components as well as (if possible) real hardware items.

Online videos of these hardware and software in operation can make lessons more engaging. There 
are also many good online animations that make this subject area more accessible. For example, the 
following YouTube animation gives a simple explanation of the main components of the motherboard: 
https://www.youtube.com/watch?v=HB4I2CgkcCo (approx. 2 minutes)

Live demonstrations, such as inputting an image using a scanner (input devices) or checking a 
computer for viruses (utility software), should be included, where possible.

Think-Pair-Share: Using mixed-ability/mixed-gender groups (addressing inclusivity and equity), 
learners think, write and discuss the defi nition of a computer and its purposes, software and hardware 
components. For example, input devices should be discussed to address accessibility issues for learners 
with disabilities such as visual impairment, dyslexia, dysgraphia. Images of adapted hardware such as 
braille keyboards could be distributed/displayed to initiate further discussion.

Tell-it-all: In small groupings, (ability, language, background, gender, etc.), learners list some 
hardware and software related words from a puzzle (such as a wordsearch) and group the words into 
hardware and software components. Some groups can feedback examples of found hardware items 
and identify possible uses for this hardware. Other groups can do the same for software found.

Games: In groups or involving the whole class, games and puzzles that reinforce the focal areas 
being studied can increase learner engagement. Examples include: hangman, sorting/matching, 
wordsearches, and crosswo rds.

Key Assessments
Teachers should assess learners during the learning process. Marks can be assigned to presentations, 
contributions during work, research projects, and more.

The summative assessment questions below are only to serve as a guide for the teacher when creating 
questions to measure learners’ comprehension of the two focal areas.

DOK Level 1: Recall/Reproduction
1. The physical components of a computer are collectively called……
2. Name three output devices.
3. Label the keyboard, mouse, monitor and printer in this image:
4. Label a blank 5-block computer system diagram.
5. List three examples of an application software.
6. Name an operating system.
7. State the name of the hardware component that is often referred to as ‘the brain of the computer’.

Figure 2.1: Checking Word version
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DOK Level 2: Skill/Concept
1.	 Explain the difference between hardware and software.
2.	 State the name of the software that manages and organises computer resources such as CPU, 

RAM, and hard disk.
3.	 State two possible uses for a computer in an office.
4.	 Describe a possible use of a scanner by a teacher.
5.	 Name the two main categories of software and explain the difference between them.
6.	 What type of software is a backup program?
7.	 Label the processing hardware shown in this image:

DOK Level 3: Strategic Thinking
1.	 Distinguish between application software and systems software.
2.	 Explain the relationship that the operating system has with computer hardware and 

application software.
3.	 Backup programs are necessary utility software in a computer system. Explain why this is so.

DOK Level 4: Extended Strategic Thinking
1.	 It is the hardware part of the computer that makes the computer intelligent and not the software. 

True or False? Give reasons for your answer.
2.	 Investigate the differences between hard-disk drives and solid-state drives. Write a short report 

on your findings.
3.	 Explain the issues that would arise if a computer system did not have BIOS.
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Wee k 2
Learning Indicators:

1. Create, Edit and Format text and paragraphs (Cut, Copy, Bold, Italic, Tables, Find 
and Replace, Format Painter, Spelling & Grammar check, Styles) using desktop/online 
computing tools (word processing software e.g., MS Word, Google Docs) keyboard, 
mouse etc.

2. Save and print documents (Save, Save As, Print)

Theme/Focal Areas:
1.  Basic	fi	le	handling	in	Word:	Creating	a	new	document,	saving	a	document,	

opening an existing document, printing a document.
2.  Basic editing tools in Word: Cut, Copy and Paste, Find and Replace
3.  Basic reviewing tools in Word: Spelling and Grammar checks, Thesaurus

What Is Word Processing?
Word processing is the use of a program called a word processor running on a computer that allows 
users to create, edit, format, and store primarily text-based documents. Microsoft (MS) Word is the 
most commonly used word processor but other word processors exist such as Pages and Google Docs. 
All the instructions and screenshots in this manual are for MS Word 365.

Before learners can begin using the many features of Word properly, they need to know several basic 
skills and concepts. Identifying the parts of the Word screen components, creating. opening and 
saving a document, and moving around within it are the foundations to build on. First of all, however, 
it is important to establish which version of Word is being used. This will help teachers and learners 
choose the correct paper-based or online manuals which they can reference to expand their word 
processing skills.

Establishing Word Version
Create a new Word document or open 
an existing Word document.

Choose File from the top left corner, 
and then click either Account or Help
on the left navigation bar. You will see 
your Offi ce version and information 
under Product information, on the 
right side of the window.

Figure 2.1: Checking Word version
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Parts of the Word Window
Being familiar with the names and various parts of Word window and their function(s) is very useful 
and will be necessary for learners to know when following the guide instructions in this manual.

Figure 2.2: Word Window

All the labelled parts shown in Figure 2.2 have a role to play in the word processor.

For example, the ribbon is a command bar at the top of the window in Offi ce programs such as Word. 
Ribbons are designed to help the user to quickly fi nd the commands that they need to complete a task. 
The ribbon organises a program’s features into a series of tabs at the top of the screen and these tabs 
are composed of groups of commands with a common purpose. The Home tab is the default when a 
new Word document in created. The second group in this ribbon tab is Font.

Figure 2.3: Home Ribbon

Learner Guidance and Tasks
The tasks below include step by step instructions to use the following in Word:

• Basic fi le handling tools
• Basic document editing tools
• Basic document reviewing tools
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Basic	fi	le	handling	Guidance

A. How to create and save a new document:

1. Start Microsoft Word.
2. Click Blank document. (A new blank document appears)
3. Click the File tab
4. Click on Save As command (or Save a Copy if using Word 365)
5. Make the necessary changes in the Save As dialogue box.
6.  Click Save.
7. Type in your text. The text you type will be inserted into the document.
8. Click on Save regularly to update the current content of the last stored fi le.
9. Click on the X in the top right-hand corner of the Word window or select File > Close. You may 

be prompted to save again at this point.

Use File> New when starting a new blank document from within Word. Use Save As when saving a 
document for the fi rst time. It is good practise to save the blank document using an appropriate fi le 
name and folder before you start entering text.

Task 1

Enter sections of text as instructed by your teacher and save with suitable fi le names.
Text entry conventions
• Press Enter to indicate the end of a paragraph, not the end of a line.

• Many WP users choose not to indent paragraphs and insert an extra line instead. In this case 
press Enter twice to move on to a new paragraph.

• Traditionally, the rule was two spaces after a full stop and one after a comma. Nowadays, it 
is more common for WP users to have just one space after both a comma and a full stop.

Task 1 may be repeated a number of times using different text. This will build up a set of fi les for the 
learner to use for the editing tasks that follow.

B. How to open an existing document for editing

1. Click on the File Explorer icon. [ ]
2. Go to the folder location where your fi le is stored.
3. Open the document you wish to edit by double-clicking on it.

From within Word, the steps would be:

1. Click the File tab.
2. Click Open. The Open screen appears, select/browse a location, and select the fi le you 

want to open.
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C. How to print a document

1. Select File > Print.
2. To preview each page, select the forward and backward arrows at 

the bottom of the page.

Figure 2.4: Print dialogue box

If the text is too small to read, enlarge using the zoom slider at 
the bottom of the page.

3.  Choose the number of copies, and other options you want.
Check that the correct printer is selected and online.

 Printer properties will give you additional options 
including colour.

Select the Print button.

Task 2

1. Open one of the fi les saved in Task 1.
2. Add your name and class to the bottom of the text.
3. Save your updated document.
4. Print out this document (black and white, single sided).

Basic document editing Guidance

Often before editing text, you will need to select it. This is also called ‘highlighting text’.

The Undo tool will revert the last edit. This action can be reverted by using the Redo tool.

Copy and Paste – duplicates the selected item. The selected item can be found in both original and 
the new, pasted location(s). Cut and Paste – duplicates the selected item then deletes the original. The 
selected item can be found only at the new, pasted location (the item has moved from one location 
to another).

If you have a word used throughout a document that you want to replace with another word, then the 
Find/Replace tool can quickly complete this task.

D. How to undo the last operation

1.  Use the keyboard shortcut (Ctrl + Z) or press the Undo button in the top left of the Word screen.
2.  For multiple undos, click the arrow next to the  Undo button. Pick the desired action(s) to undo 

from the drop-down menu. 
2.  Use the keyboard shortcut (Ctrl + Y) or press the Redo button to reverse this action.
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E. How to select text in a Word document

1. Move the I-beam pointer [ ] to where you wish to select text.
2. To select a word, double-click the word.
3. To select an entire line of text, move the I-beam to the left of the line until it turns into a right-

pointing arrow [
To select an entire line of text, move the I-beam to the left of the line until it turns into a right-

] then click.
4. To select a paragraph, triple-click the paragraph.
5. To select any amount of text, click and drag the I-beam over the text to highlight it.
6. To select an entire document: move the I-beam to the left of any text until it turns into a right-

pointing arrow [
To select an entire document: move the I-beam to the left of any text until it turns into a right-

], then triple-click. Alternatively, click the Home tab, then Editing > Select, 
or Editing > Select All. Use the keyboard shortcut (Ctrl + A) can be used for Select All.

F. How to delete (or remove) text

Method 1

1.  Select the text you wish to delete.
2.  Press the Delete key (on the keyboard).

Method 2

1. Move the I-beam pointer to the text you want to delete. Click to set the insertion point there (a 
blinking vertical line).

2. To delete text to the left of the insertion point, press the Backspace key on the keyboard (On a 
Mac keyboard, press the Delete key).

3. To delete text to the right of the insertion point, press the Delete key on the keyboard. (On a 
Mac keyboard, press the Fn key plus the Delete key.)

4. Click on File tab
5. Click on Save Or use the keyboard shortcut (Ctrl + S) to effect the changes.

G. How to copy/cut and paste

1. Open the document you wish to edit.
2. Select the item you wish to copy or cut.
3. Then either:

• Right-click the highlighted item and click Copy or Cut.
• Choose Copy or Cut from the Home tab Ribbon, Clipboard 

group as shown in Figure 2.5.
• Use the keyboard shortcuts
 copy: Ctrl + C or Cmd + C on a Mac and Cut: Ctrl + X or Cmd 

+ X on a Mac

4. Position the insertion point where you wish to insert the item.
5. Select the fi rst Paste option from the H ome tab as shown in Figure 

2.6. You can also use your keyboard by pressing Ctrl + V or Cmd 
+ V on a Mac.

6. Click on File tab
7. Click on Save or the keyboard shortcut (Ctrl + S) to effect 

the changes.

Figure 2.5

Figure 2.6
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H.	How	to	use	the	fi	nd	and	replace	tool

Method 1

1. Open the document you wish to edit
2. Select the text to be replaced
3. Click on Replace under Editing of the Home tab – see Figure 2.7. to display the 

Find and Replace Dialogue box.
4. Type the word that you want to replace and the new word.
5. Use the More >> button to see further options – Figure 2.8.
6. Click on either Replace (to replace one at a time or skip) or Replace All (to replace all occurrences 

of the selected text with the new text).

Method Two

1. Use the keyboard shortcut Ctrl+H t to display the Find and Replace dialogue box
2. Type to type the text you want to fi nd in Find What box
3. Type the text you want to replace with in Replace With box
4. Select and click on either Replace (to replace one at a time or skip) or Replace All (to replace 

all the selected text with the new text)

Figure 2.8: Expanded Find/Replace dialogue box

Task 2

1. Open one of the fi les saved in Task 1 or a fi le given by your teacher.

2. Save regularly as you complete steps 3 to 9.

3. Using Cut and Paste, swap the fi rst and last paragraph in the document.

Figure 2.7
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4. Copy and Paste at least two paragraphs so that you will have some duplicate paragraphs.

5. Use Method 1 on page 18 to delete these duplicated paragraphs.

6. Copy two sentences from each paragraph to the end of the document.

7. Undo the steps completed for step 6.

8. Use the Find/Replace tool to fi nd all occurrences of a word in the document and replace it 
with another word with a similar or same meaning.

9. Repeat step 8 but this time only replace the second and third occurrence of the found word.

Reviewing a Document Guidance

The default setting for Spelling and Grammar is on (ticked). 
This can be checked by going to the Review tab.

I. How to correct spelling errors

1. Words underlined with a red wavy line indicate a misspelt word – see Figure 2.9.
2. Right-click one of these words.
3. Select the correct spelling from the suggested list to correct the spelling error. For each error, 

Word will offer one or more suggestions. You can also choose to ignore the spelling error 
prompt or add the word to Word’s dictionary as shown in Figure 2.9.

Figure 2.9

J. How to correct grammatical errors

1. A word(s) with a double-blue underline indicates a possible error with grammar – see Figure 2.10

Figure 2.10

2. Right-click one of these words.
3. Select a word(s) from the suggested list to correct the error. You can also choose to ignore the 

error prompt by selecting Ignore Once.

K. How to use the synonyms tool

1. Right-click a word for which you wish to fi nd a synonym for.
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2.	 Click the Synonyms command from the pop-out menu as shown in Figure 2.11.
3.	  Find a desired word in the list and click it to replace the original word.
4.	 If none of the synonyms are desired, click the Thesaurus option to open the full thesaurus—the 

Thesaurus pane will appear.
5.	 Find a desired word in the Thesaurus pane list, right-click it and then click Insert.
6.	 Close the Thesaurus pane.

Figure 2.11

Task 3

1.	 Open a Word file that you have saved earlier or a file given to you by your teacher.

2.	 Save this file with a different filename if you need to keep the original file unedited.

3.	 Click on Save or keyboard shortcut (Ctrl + S) to effect changes as you work through steps 
4 to 7.

4.	 Replace some of the words in the documents with misspelt words using Find/Replace. Some 
words in the document will now be underlined with a red wavy line.

5.	 Make some deliberate grammatical errors in the text. Some word(s) will now be underlined 
with a double-blue line.

6.	 Correct these spelling and grammar errors as per instructed above.

7.	 Use the Synonym tool to change a word or phrase in the document to another word or phrase 
that means exactly or nearly the same.

Pedagogical Exemplars
These examples are only to serve as a guide to the teacher.

Starter: A sound understanding of basic file management is a requirement of any ICT course and 
instructions on how to effectively organise folders of digital files is an important content that belongs 
in the first practical lesson. Learners need to be encouraged to follow a consistent method for naming 
their files and folders. Meaningful filenames should always be used (no Document1’s!) Learners’ 
names should be added as footers to documents, in particular, to any documents that are to be printed. 
The principles of effective file management will need constant reinforcing throughout the course.

Each learner should create a folder named ‘ICT1’ with three subfolders: ‘Computing Systems’, 
‘Word’, and ‘PowerPoint’ to save their work. The teacher may have to demonstrate how to create, 
rename and delete folders if learners have not already done this/ have forgotten these operations.
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Class: After an open discussion on what a word processor is, organise a brainstorming session on 
the possible user/uses that could use of a word processor. One example should be given to start the 
session, such as a student writing an essay for a History class.

Pairs/small groups: Each group take at least three of previously identifi ed uses of a word processor 
and list the hardware required. Then, feedback should be given to the class on the list they have 
compiled for each given use.

Direct instruction: First outline the components of the home WP screen using the correct terminology 
such as ribbon, tabs, and taskbar. Explain the basic fi le management, editing and reviewing tools in 
Word, breaking them down into manageable blocks for the learners. The order of delivery as given 
in the Learner Guidance and Tasks notes is advised. Using the projector, demonstrate how to use 
these tools in the chosen WP, often giving two or more demonstrations of some tools to consolidate 
understanding. Invite guidance from learners during the second or subsequent demonstrations.

Practical sessions and Project-based learning: Learners should engage in practical sessions and 
project-based learning to create, save, edit and format educational artefacts using word processing 
software. Have a number of similar tasks (increasing in complexity, if possible) for the practise of 
each tool/set of tools. The tasks in the manual could be adapted and expanded to fi t.

Some of these practical tasks should relate to content from Week 1 and will help consolidate learners’ 
understanding of basic hardware and software concepts. Practical tasks should be considered where 
the learner manipulates text that relate to the features of a WP. For example, the learner has to 
correctly reorder a Word list of steps to describe how to use the Find and Replace tool. Other tasks 
may just focus on a feature of a WP without an ICT context. For example, word processing a song 
and using copy and paste for the chorus. Some tasks should be more open-ended and allow learners 
some autonomy, such as create a table showing the name and current/last club of your fi ve favourite 
football players. Pupils could work in pairs on some of the activities, with the teacher choosing the 
groupings.

Independent learning should be nurtured so that learners can become confi dent and competent digital 
users. Guidance notes and eManuals/ paper-based manuals on Word should be made accessible to 
learners to refer to when they encounter a problem/forgotten a step. If the internet is available, learners 
can be directed to online help. Word help & learning (microsoft.com) has excellent easy-to-follow 
guides (including videos) on using the various Word 365 tools.

The practical tasks for this week should culminate with a report consisting of at least three pages of 
text organised under various headings. This report could be about a learner’s family and interests; this 
would give the teacher more information about his/her students.

K ey Assessments
Teachers should assess learners during the learning process. Marks can be assigned to presentations, 
contributions during work, research projects and more.

The summative assessment questions below are only to serve as a guide for the teacher when creating 
questions to measure learners’ comprehension of the three focal areas.

DOK Level 1 (Recall and Reproduction)

1. Name a word processing program.
2. Identify the ribbon on a screenshot of a Word window.
3. What is the keyboard shortcut for undoing the last operation when editing a Word document?
4. State the name of the type of error that is indicated by a red squiggly line ?
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5.	 A document consists of three paragraphs. Which of the following operations would be used to 
move the first paragraph to the end of the document?

a.	 Move and Paste
b.	 Copy and Paste
c.	 Cut and Paste

DOK Level 2 (Skills and Concepts)
6.	 Explain why it is important of save regularly when word processing a document?
7.	 Demonstrate how to use the Find/Replace tool in Word to correct all occurrences of a misspelt 

word throughout a document.
8.	 Explain how using copy and paste can save time when creating a Word document.
9.	 Describe one tool in the Review tab in Word that you have used in a lesson and what you 

used it for.
10.	 a. 	 Word process a few sentences about a computer monitor. Save your document.

b. 	 Use the Synonym tool to replace word ‘monitor’ with another word with the same meaning.

DOK Level 3 (Strategic Thinking)
11.	 Describe two different methods to change all occurrences of a misspelt word in a Word 

document. Evaluate both methods in terms of speed and accuracy.
12.	 Word process and save the Ten Green Bottles rhyme using the appropriate tools to speed up 

entry of text:

	 Ten green bottles hanging on the wall, 
Ten green bottles hanging on the wall, 
And if one green bottle should accidentally fall, 
There’ll be nine green bottles hanging on the wall.

This pattern continues until the number of bottles reaches zero. The final verse ends “There’ll be no 
green bottles hanging on the wall”.

13.	 Create a step-by-step guide for how to print only the first page of a document in colour.

DOK Level 4 (Extended Thinking)
14.	 Explore the features of this tool in Word. Explain what Editor tool can be used for.
15.	 Critique the accessibility features in Word for users with disabilities (for example, visual 

impairment) and propose recommendations for improvement.
16.	 Predict how advancements in artificial intelligence and natural language processing will impact 

the future of document editing in Word.
17.	 Investigate the environmental impact of user file storage on local hard disk drives, and explore 

more sustainable alternatives for saving and archiving digital documents. Create a Word report 
on your findings.
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Week 3
Learning Indicators:

1.	 Create, Edit and Format text and paragraphs (Cut, Copy, Bold, Italic, Tables, Find 
and Replace, Format Painter, Spelling & Grammar check, Styles) using desktop/online 
computing tools (word processing software e.g., MS Word, Google Docs) keyboard, 
mouse etc.

2.	 Format the overall appearance of a page through colours, watermarks, headers and 
footers, page layout, paragraph and line, change capitalisation, bordering and shading, 
perform bullets and numbering, do page column, tables, graphics) using desktop/online 
computing tools (word processing software e.g., MS Word, Google Docs) keyboard, 
mouse etc.

Theme/Focal Areas: 
1. 	 Formatting tools: Changing font properties (colour, emphasis, capitalisation)
2. 	 Creating and formatting tables (including bordering and shading)
3. 	 Inserting graphics
4. 	 Inserting watermarks

Formatting Basics
Formatting is the fine art of making your documents easy to read and attractive. Good formatting 
distinguishes different parts of your text and helps your readers take in your message. You can apply 
formatting to just about every element of your document, from a single character to entire paragraphs. 
Body text needs to be readable and easy on the eyes. Headings should be prominent and be consistent 
throughout your document. Important words need to resonate with emphasis. Quotes and references 
should be set off from the other text.

Formatting changes the looks of the document and can make it beautiful and attractive. Formatting 
changes include: changing font, font style, font colour, font size, text alignment, line spacing, 
background colour, and inserting images.

Formatting is a two-step process. First, tell Word which text you want to format by selecting it. Then 
format away. Or, you can set up your formatting options first, and then begin to type. Your letters and 
words will then be formatted as desired as you type.

Formatting includes selecting a font, font size, and font style (such as bold or italics). At the paragraph 
level, you apply indents, bullets, and line spacing. For each section of your document (even if there is 
only one), you can set the page size, orientation, and margins. You can apply most types of formatting 
via the ribbon tabs, the mini-toolbar, or keyboard shortcuts.

Small caps for headers
Capitalised text for the body of a paragraph is not advised as it is difficult to read. However, capitalised 
text is a good way to distinguish a heading or subheading from body text. Small caps can be used as a 
form of emphasis that is less dominant than all uppercase text. Applying the small caps format gives 
initial letters full-sized capitals while the remaining letters get small capitals, as illustrated here: Text 
with small caps, TEXT WITH NORMAL CAPITALS.
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Formatting Shortcuts
Keyboard shortcuts let you perform common tasks like saving, inserting page breaks, and changing 
fonts without touching the mouse. As a result of Word’s evolution, most editing tools have more than 
one keyboard shortcut. A new set of keyboard shortcuts came with Word 2007’s new ribbon feature 
but the traditional shortcuts still work. Some common formatting shortcuts include:

Shortcut Key Functions
Ctrl + I Italicise text
Ctrl + B Bold text
Ctrl + U Underline text
Ctrl + < Decrease font size
Ctrl + > Increase font size
Ctrl + = Subscript (type very small text just below the line)
Ctrl + Shift ++ Superscript (type very small text just above the line)
Alt +H, 7) Change case

Watermarks
Watermarks are generally used to protect content, indicate the status or classifi cation of a document, 
and add branding. They are a visual reminder to the reader of what document they are reading is, and 
how they should manage the contents.

Figure 3.1
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Tables and Illustrations

Figure 3.2

Tables can be used to organise content and make the content easier to read. The inclusion of graphics 
in a document has many uses and benefi ts, including helping to communicate ideas and increasing the 
reader’s comprehension.To add a table or an illustration to a document, the Tables and Illustrations
groups tools in the Insert tab are used. When a table or illustration is added, an extra pair of tabs or 
one tab is added to handle the further editing and formatting of these graphic objects.

The guidance notes which follow cover the insertion of tables and pictures. Similar steps will be 
required to insert SmartArt (e.g.an organisation chart diagram) or a shape (e.g. a block arrow).

Learner Guidance and Tasks
The tasks below include step-by-step instructions to do the following in Word:

• Use basic formatting tools
• Insert a table
• Insert a watermark
• Insert a graphic

Basic formatting Guidance
A. How to apply font style, font colour, and font size changes to a text

1. Select the text you want to emphasis.
2. Then either

• Right-click the highlighted item and click B, I or U (for bold, italic or underline) as shown 
in Figure 3.3.

• Click B, I or U on the Home tab Ribbon (Font group).
• Use the keyboard shortcuts: bold (Ctrl + B), italic (Ctrl + I), or underline 

(Ctrl + U). Use Cmd instead of Ctrl for Macs.

3. Click B, I or U again or Undo button to cancel the format change.
4. Similarly for changing the font style, size, and colour of writing, fi rst select the text.

5. Then choose the formatting options you want from the Font group – see Figure 3.4.
Use the down arrows to see more possible sizes and colours.

Figure 3.3
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Figure 3.4

6. As mentioned previously, formatting settings can be turned on in advance of text being entered. 
If the settings for Font were as shown in Figure 3.4, then the text entered would be in the Arial 
font, italicised, size 16 and green.

7. The Font dialogue box (Figure 3.6) can also be used to set 
formatting styles.
This can be accessed by clicking on the arrow as shown in 
Figure 3.5.

Figure 3.6: Font dialogue box

B. How to use the change capitalisation tool

1.  Select the text you want to change.
2.  Click on the arrow beside the Change Case tool
3.  Choose the case that suits your need from the list of options – see 

Figure 3.7.
4.  The Small caps can be applied using the Font dialogue box 

(Figure 3.6).

C. How to use the format painter tool

1. Select the text or graphic that has the formatting that you want to copy.
2. On the Home tab, select. Format Painter in the Clipboard group as shown 

in Figure 3.8.
3. The cursor changes to a paintbrush icon.

Figure 3.5

Figure 3.7

Figure 3.8
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4. Use the brush to paint over a selection of text or graphics to apply the formatting.
5. To stop formatting, press ESC.

Task 1

1.  Open a Word fi le that you have saved earlier or a fi le given to you by your teacher.
2.  Save this fi le with a different fi lename if you need to keep the original fi le unedited.
3.  Click on Save or keyboard shortcut (Ctrl + S) to effect changes as you work through steps 4 and 5.
4.  Experiment with making formatting changes as instructed above or make the formatting changes 

specifi ed by your teacher.
5.  Use Format Painter to quickly apply the same formatting, such as colour, font style, size, and 

capitalisation to other parts of the document.

Tables Guidance
D. How to inserting a table

1. Open the document you wish to edit and position the insertion point where you wish to 
insert the table

2. Click on Insert tab
3. Click on Table group
4. Move the point over the grids to select desired rows and columns and click to draw the table – 

see Figure 3.9.

Figure 3.9: Inserting a table in Word 

5. Enter the contents into your table. Use the Tab key to move from one cell to the other in 
your table.

6. When you click anywhere inside the table, two additional tabs appear in the Ribbon: Table
Design and Layout – see Figure 3.10. The buttons in these tabs will enable the user to format 
and edit the table.

7. Use the Insert and Delete buttons in the Layout tab to add/remove rows/columns, if required.

Figure 3.10: Table Tools ribbon group
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E. How to add a border and shading to a table

1. To add a border, fi rst select a cell, multiple cells, or the whole table. Borders will only be 
added to the cell or cells you have selected.

2. Specify the border style. As indicated in Figure 3.11, you can individually select a border line 
style, weight (i.e. thickness), and colour using the buttons from the Table Design tab, or use 
an existing border style. Use the arrows to see the full range of options.

Figure 3.11: Table borders and shading in Word

3.  Similarly for shading, fi rst select the cell, multiple cells or the whole table that 
you want to add shading to.

4.  Click on the Shading list arrow in the Table Design tab.
5.  Choose the shade colour from the given palette of colours.

Task 2

1.  Create a table in Word with four columns and six rows. Save using the fi lename ‘Hardware 
Table’. Save regularly as you complete steps 2 to 10.

2.  The fi rst row should be populated as follows:

Input Output Processing Storage

3. Complete the table with the names of hardware items in each column.
4. Shade each column with a different colour.
5. Insert another column to the table and add the following words: Communication, Modem, 

Router, NIC, Switch, Hub.
6. Embolden each word in the fi rst row
7. Capitalise all words in the fi rst row in a single operation.
8. Apply a 3 pt black outside border to the table.
9. Change the font colour of the fi rst input device in the fi rst column.
10. Use the Format Painter to:

a. Copy the formatting applied in step 9 to the remaining input devices.
b. Copy the shading from the second column to the last column.

Figure 3.12 
Shading 

colours List
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Graphics Guidance

F. How to add a watermark to your document

1. On the Design tab, click Watermark > Custom Watermark/

Figure 3.13

2. Choose the text or picture option, and customise to suit your requirements.

Figure 3.14

G. How to insert a picture

Figure 3.15
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1.	 On the Insert tab, click Pictures.
2.	 Then do one of the following:

•	 Click This Device for a picture on your computer.
•	 Click Stock Images for high quality images or backgrounds.
•	 Click Online Pictures for a picture on the web.

3.	 Select the picture you want, and then click Insert.
4.	 Use the tools in the Picture Format tab to format and edit the picture.

Task 3

1. 	 Create a new document and save using the filename ‘Hardware Images’. Save regularly as 
you complete steps 2 to 5.

2.	 Set font to Calibri, size 16, colour Red and add to the following headings to the first three 
pages: Input Devices, Output Devices, Storage Devices.

3. Insert images (stock images, images from the internet, or images provided by your teacher) of 
hardware devices/media in each page to match the page heading.

4.	 Add a different colour border to each input device that you have inserted.

5.	  Add the watermark ‘Confidential’ to the pages in your document.

Task 4

1. 	 Create a new document and save using the filename ‘Software Images’. Save regularly as 
you complete steps 2 to 5.

2.	 Add the following headings to the first two pages: Applications Software, Systems Software.

3. 	 Format both headings to make them more prominent and attractive.

4. 	 Add a short description to match each heading.

5.	 Change the colour, font type and size of the first description.

6.	 Copy the format for the first description to the second description (on page 2) in a single 
operation.

4.	 Insert images (stock images, images from the internet, or images provided by your teacher) 
in each page to match the page heading.

Pedagogical Exemplars
These examples are only to serve as a guide to the teacher.

Direct instruction: After an open discussion about what is meant by the term ‘formatting’, give 
learners the opportunity to volunteer what type of formatting in Word (if any) they have used before. 
Use screenshots or projections of the Word Home, Insert and Design tab ribbons to identify the 
various tools/buttons they will encounter this week. Break down the content into manageable blocks 
for learners. The order of delivery as given in the Learner Guidance and Tasks notes is advised, 
with at least one lesson each devoted to tables in Word and pictures in Word. Using the projector, 
demonstrate how to use the selected formatting, table and picture tools, often giving two or more 
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demonstration of each to consolidate understanding. Invite guidance from learners during the second 
or subsequent demonstration(s).

A quick recap of the last lesson is a good way to begin each lesson as learners will continue to use 
the Word features introduced previously. A plenary at the end of each lesson is valuable and should 
be the norm, summarising the focal areas covered and giving the pupils the opportunity to reflect of 
what they have learned.

Practical sessions and Project-based learning: Engage in practical sessions and project-based 
learning and to create, save, edit and format educational artefacts using word processing software. 
Have a number of similar tasks (increasing in complexity, if possible) for the practise of each tool/set 
of tools. The tasks given in the manual could be adapted and expanded to fit.

Some of these practical tasks should relate to content from Week 1 and will help consolidate the 
learning of basic hardware and software concepts. Practical tasks should be considered where a 
learner manipulates text/images that relate to the features of a WP. For example, a learner has to 
reorder a list to given steps to correctly explain how the Format Painter tool can be used. Other tasks 
may just focus on a feature of a WP without an ICT context. Include tasks that are more open-ended 
and allow learners some autonomy, such as the creation of a table showing the name, image and 
features of their five favourite animals. Pupils could work in pairs on some of the activities, with the 
teacher choosing the groupings.

Independent learning should be nurtured so that learners can become confident and competent digital 
users. Guidance notes and eManuals/ paper-based manuals on Word should be made accessible to 
learners to refer to when they encounter a problem/have forgotten a step. If the internet is available, 
the learners can be directed to online help.

Word help & learning (microsoft.com) has excellent easy-to-follow guides (including videos) on 
using the various Word 365 tools. One practical task for this week could be to return to the report 
created at the end of the second week and use various formatting tools to make it more attractive, also 
adding further details in the form of tables and pictures.

Key Assessments
Teachers should assess learners during the learning process. Marks can be assigned to presentations, 
contributions during work, research projects, and more.

The summative assessment questions below are only to serve as a guide for the teacher when creating 
questions to measure learners’ comprehension of the four focal areas.

DOK Level 1 (Recall and Reproduction)
1.	 Complete the sentence: Document f____________ refers to the way a document looks and is 

visually organised.
2.	 What is the keyboard shortcut for underline?
3.	 State what formatting has been applied to the text in Figure 3.16 to give the appearance of the 

text in Figure 3.17.

ICT is fun! ICT is fun!
Figure 3.16 Figure 3.17

4.	 Calibri is the name of

a.	 a font
b.	 a font style
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c. a font size

DOK Level 2 (Skills and Concepts)
5. An essay is being word processed with the title ‘A brief history of Ghana’. Describe three types 

of formatting that could be applied to make this title more prominent.
6. Use Word to create the following table:

Mammals Reptiles Amphibians
Dogs Snakes Frogs
Elephants Lizards Toads
Lions Tortoises Salamanders

7. a.  Describe what is meant by a watermark.

b.  Give one reason someone would watermark a document.

DOK Level 3 (Strategic Thinking)
8. Evaluate the impact of applying formatting throughout a document to enhance readability and 

visual appeal.
9. Open the document with the table from question 6.

a. Evaluate the tabular presentation with the horizontal lists presentation in Figure 3.18 in 
terms of how easy it is to read.

Mammals: Dogs, Elephants, Lions
Reptiles: Snakes, Lizards, Tortoises

Amphibians: Frogs, Toads, Salamanders
Figure 3.18

b. Insert two additional columns to the table. Enter ‘Fish’ and ‘Bird’ in the fi rst row of these 
columns. Populate the remaining cells in these columns with the names of three fi sh and 
three birds.

c. Add shading to your table with a colour(s) of your choice.

10. Create a step-by-step guide for how to add the watermark ‘Draft’ to a document.

DOK Level 4 (Extended Thinking)
11. Explore the following two table tools in Word:  and .

Explain what these tools can be used for and demonstrate their use in a table. You choose the 
table content.

12. Experiment with the tools in the Adjust group of the Picture Format Tab in Word - see Figure 
3.19. Using adjusted images to support your descriptions, write a short summary on the 
function(s) of at least three of these tools.

Figure 3.19

13. Predict how advancements in augmented reality technology could revolutionise the way users 
create and interact with formatted text and paragraphs in a digital document.
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Week 4
Learning Indicator:  Format the overall appearance of a page through colours, watermarks, 
headers and footers, page layout, paragraph and line, change capitalisation, bordering and 
shading, perform bullets and numbering, do page column, tables, graphics) using desktop/online 
computing tools (word processing software e.g., MS Word, Google Docs) keyboard, mouse etc.

Theme/Focal Area: Basic layout tools for lines, paragraphs and pages in Word, 
including page layout, alignment, headers and footers, and page 
columns

Document Layout
Layout concerns the physical appearance and form of the document pages and the document as a 
whole. Document layout exploits a variety of tools including paragraph tools and page layout tools. 
The paragraph tools enable the text alignment to be adjusted, indentation added, a border around 
a paragraph created, and much more. The page setup settings will adjust the general setup of the 
document such as the orientation, the margins, and the width and height. Page breaks can be inserted 
to control where a page ends and where a new page begins. A header is a text that is placed at the top 
of every page, while a footer is placed at the bottom, or foot, of every page.

Learner Guidance and Tasks

Layout Guidance
A. How to adjust the page setup settings – orientation, columns, and margins

1.  Select the appropriate button from Page Setup group in the Layout tab – see Figure 4.1.

Figure 4.1

2.  For orientation, select Landscape or keep it as portrait -see Figure 4.2.

Figure 4.2

3. For columns: the content of a page or a paragraph (highlight the paragraph fi rst) can be presented 
in columns by selecting the required number of columns as shown in Figure 4.3.
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Figure 4.3

4. Many of the page settings can also be made via the Page Setup dialogue box which will be 
displayed by clicking on the arrow in the bottom right-hand side of the Page Setup group (see 
Figure 4.1).
The default page margins are shown in Figure 4.4 and can easily be changed.

Figure 4.4

5. Clicking on Layout > Borders will display the Borders and Shading dialogue box (Figure 4.5) 
from where you can apply a page border of different styles and thickness, and a colour shading 
to the document paragraphs. Selecting a paragraph in advance will apply the border settings to 
that paragraph only.
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Figure 4.5

6. To apply a page border, go to Design> Page Borders  and set the style, colour, etc. of 
the border.

Figure 4.6

7. To insert a page break, go to Layout > Breaks > Page (see Figure 4.6)
8. Or use the keyboard shortcut (Ctrl + Enter), Shift + Enter for a Mac.
9. You can also apply pagination settings from the Paragraph dialogue box (Figure 4.7) so that 

headings and paragraphs behave the way you want them to.

Figure 4.7

There are four settings:

1. Widow/Orphan control: Single lines abandoned at the top (widows) or bottom (orphans) of 
the page look out of place. Turn on this checkbox, and Word keeps the whole family, er, 
paragraph together.

2. Keep with next: Certain paragraphs, like headings, need to stay attached to the paragraph that 
comes immediately after them. Choose the Keep with the next option for your headings, and 
they always appear above the following paragraph.

3. Keep lines together: Sometimes you have a paragraph that shouldn’t be split between two pages, 
like a one-paragraph quote or disclaimer. Use this option to keep the paragraph as one unit.
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4. Page break before: Use this command with major headings to make sure new sections of your 
document start on a new page.

B. How to add a header and footer

1. Select Header or Footer from the Insert tab (Figure 4.8).
2. Select Edit Header or Edit Footer.
3. The Header & Footer tab (Figure 4.9) appears, and by default, the cursor is in 

the centre section of the header/footer.
4. Type the text you want in the header/footer.
5. More options such as inserting page numbers can be set in the Header & Footer tab.
6. Select Close Header and Footer when fi nished.

Figure 4.9: Header & Footer Tab

Task 1

1.  Open a Word document that you have saved earlier or a fi le given to you by your teacher. 
This Word document should have at least 4 pages.

2.  Save this fi le with a different fi lename. Click on Save or keyboard shortcut (Ctrl + S) to 
effect changes as you work through steps 3 to 9.

3.  Add ‘Practising Word Tools’ as a header, and your name and page number as a footer.

4.  Change the top and bottom page margins to 3cm and the left and right margins to 2cm.

5.  Insert a page break at the end of the last page and copy and paste some text to populate the 
blank page that results.

6.  Select the fi rst paragraph of the fi rst page and change the format from one to three columns.

7.  Change the format of another paragraph (you choose which one) to two columns.

8.  Change the page orientation to landscape for the whole document.

9.  Add a 3pt black line border to one of the single column paragraphs in the document.

C. How to set paragraph alignment

Align Left
Align the lines in the paragraph fl ush on the left side and ragged on the right. Left alignment is standard for letters, reports, and many business documents. 
To do this, click on the align left symbol on the paragraph group or use keyboard shortcut (Ctrl + L)

Centered
Align the lines in the paragraph fl ush on the left side and ragged on the right. Left alignment is standard for letters, reports, and many business documents. 

To do this, click on the align left symbol on the paragraph group or use keyboard shortcut (Ctrl + E)

Align Right
Align the lines in the paragraph fl ush on the left side and ragged on the right. Left alignment is standard for letters, reports, and many business documents. 

To do this, click on the align left symbol on the paragraph group or use keyboard shortcut (Ctrl + R)

Justifi ed
Align the lines in the paragraph fl ush on the left side and ragged on the right. Left alignment is standard for letters, reports, and many business documents. To 
do this, click on the align left symbol on the paragraph group or use keyboard shortcut (Ctrl + J)

Figure 4.10: Description of various text alignments and how they display

Figure 4.8
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1.  Select the Home tab.
2.  Set the text alignments by either using the alignment buttons in 

the Paragraph grouping (highlighted in Figure 4.11) or use the 
keyboard shortcuts:

• To align the text left, (Ctrl+L)
• To align the text right, (Ctrl+R)
• To centre the text, (Ctrl+E)
• To fully justify text, (Ctrl+J)
 Cmd instead of Ctrl if using a Mac.

D. How to set spacing between lines

1.  Use the Line and Paragraph  spacing tool or select the Paragraph
dialogue box from the Home tab – see Figure 4.12 and Figure 4.13.

2.  Set the set the distance between lines within paragraphs to meet your 
requirements.

Figure 4.14: Text with line spacing 
1.0, 1.5 and 2.0 

Figure 4.13

E. How to indent lines in one paragraph/ at the start of every paragraph.

Line

1.  Place the cursor at the start of the line you want to indent.
2.  Click on the Increase Indent 

Place the cursor at the start of the line you want to indent.
button. Note that there is also a Decrease Indent button.

Paragraph(s)

3. Select the paragraph or multiple paragraphs that you want to indent.
4. Go to the Paragraph group in the Home tab.

Figure 4.11

Figure 4.12
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5. Open the Paragraph dialogue box to set the type of indent (e.g. fi rst line, hanging) and how 
much to indent by – see Figure 4.13.
The hanging indent is the reverse of the fi rst line indent; the fi rst line extends to the left margin, 
while the rest of the paragraph is indented the amount shown in the ‘By’ box. This kind of 
indentation is typically used in bibliographies and for numbered questions. The indentation 
tools in the Paragraph box let you set indents with precision, and will enable the indentation of 
multiple paragraphs in one operation.

OR
6. Drag the indent shapes on the ruler which is situated below the ribbon.

Figure 4.15: Indentation tabs of Word’s horizontal ruler

• To adjust the left indent (i.e., the indentation of text from the left margin), drag the rectangle 
shape on the ruler to move all the tabs at once. This will then adjust all the text in the paragraph 
where you placed the cursor.

• To add or adjust a	fi	rst	line	indent, drag the arrow at the top of the ruler. This will indent just 
the fi rst line in the paragraph where you placed the cursor.

• For a hanging indent, select and move the triangle just above the rectangle shape (this will also 
move the left indent tab). Doing this will indent each line in the selected paragraph after the 
fi rst line.

No indent

First Line indent

Hanging indent

Hanging indent

Figure 4.16: Text with different indentations
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Do not use Tab to create a fi rst-line indent. If you use the Tab key, you have to remember to hit it at 
the beginning of every paragraph, and there is the danger of messing up your indents if you change 
the tab settings.

Pedagogical Exemplars
These examples are only to serve as a guide to the teacher.

Direct instruction: Use screenshots or projections of the Word Home, Insert and Layout tab ribbons 
to identify the various tools/buttons they will encounter this week. Break down the content into 
manageable blocks for the learners. The order of delivery as given in the Learner Guidance and 
Tasks notes is advised. Using the projector, demonstrate how the various layout formatting attributes 
can be applied. Repeat with similar demonstrations if necessary to consolidate understanding. Invite 
directions from learners on the steps to follow during the second or subsequent demonstration(s).

Practical sessions and Project-based learning: Engage in practical sessions and project-based 
learning to create, save, edit and format educational artefacts using word processing software. Have 
a number of similar tasks (increasing in complexity, if possible) for the practise of each tool/set of 
tools. The tasks given in the manual could be adapted and expanded to fi t.

Some of these practical tasks can build on work done using Word in Weeks 2 and 3. For example, 
a footer with page numbers could be added to the reports produced earlier. Practical tasks should be 
considered where the learner creates/manipulates content that relate to the features of a WP being 
covered this week – see Figure 4.9 for an example. Other tasks may just focus on a feature of a 
WP without an ICT context. For example, the word processing of a short movie quiz consisting of 
fi ve questions (centre alignment and formatting for heading, hanging indent for questions, inserting 
pictures for one or more of the questions). Pupils could work in pairs on some of the activities, with 
the teacher choosing the groupings.

Independent learning should be nurtured so that they can become confi dent and competent digital 
users. Guidance notes and eManuals/paper-based manuals on Word should be made accessible to 
learners to refer to when they encounter a problem/forgotten a step. If the internet is available, learners 
can be directed to online help. Word help & learning (microsoft.com) has excellent easy-to-follow 
guides (including videos) on how to use the various Word 365 tools.

Key Assessments
Teachers should assess learners during the learning process. Marks can be assigned to presentations, 
contributions during work, research projects, and more.

The summative assessment questions below are only to serve as a guide for the teacher when creating 
questions to measure learners’ comprehension of the focal area for this week’s lessons.

DOK Level 1 (Recall and Reproduction)
1. Complete the sentence: Text inserted in the bottom margin of every page of a document is 

called a ______________ .
2. State what type of indent is illustrated in Figure 4.16?

Figure 4.17
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3. Open a given Word document which contains a number of left-aligned headings. Centre each 
heading using the appropriate alignment tool, and save your work.

4. Alt + Enter is the keyboard shortcut for

a. a column break
b. a page break
c. a section break

DOK Level 2 (Skills and Concepts)
5. Describe what is meant by the term ‘justifi ed text’. Use a drawing/diagram to support your 

description.
6. Open a given Word document which contains four paragraphs of text, each paragraph having a 

left-aligned heading.

a. Use the alignment tools to give a different type of alignment to each heading.
b. Apply 1.5 line spacing to the second paragraph.
c. Insert your name and page number as a footer on each page.
d. Insert a page break at the end of the third paragraph.
e. Use the Ruler to indent the fi rst line of the last paragraph.

7. Demonstrate how you would apply a 3-column layout to a paragraph of text in Word.

DOK Level 3 (Strategic Thinking)
8. What problem may arise when printing in Word if the document’s page margins are too narrow?
9. What type of page orientation would be best suited to a three-column brochure? Justify your 

choice of orientation.
10. Open a given document with a confused layout. Format the document to make it more readable 

and professional looking.

DOK Level 4 (Extended Thinking)
11. Investigate the function of the following tool in Word (Layout Tab): 

Use the PrintScreen button or the Snipping Tool (Windows logo key + Shift + S or for a Mac 
Cmd key + Shift + 4) to illustrate how this function works in a short report.

12. a. Suggest reasons to support the following statements:

• The use of word processors in the newspaper industry was transformative.
• Many newspapers are moving from print to digital publishing or trying to drive more 

revenue from their digital platforms.

b.  Using the internet as a research tool, create a case study of a Ghanaian newspaper 
and how they have adapted to fi t the digital age.
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Week 5
 Learning Indicators: 

1. Create, Edit and Format text and paragraphs (Cut, Copy, Bold, Italic, Tables, Find 
and Replace, Format Painter, Spelling & Grammar check, Styles) using desktop/online 
computing tools (word processing software e.g., MS Word, Google Docs) keyboard, 
mouse etc.

2. Enhance lists by sorting, renumbering, and customising list styles using desktop/online 
computing tools (word processing software e.g., MS Word, Google Docs) keyboard, 
mouse etc.

3. Format the overall appearance of a page through colours, watermarks, headers and 
footers, page layout, paragraph and line, change capitalisation, bordering and shading, 
perform bullets and numbering, do page column, tables, graphics) using desktop/online 
computing tools (word processing software e.g., MS Word, Google Docs) keyboard, 
mouse etc.

Theme/Focal Areas:
1.  Creating lists – bulleted, numbered, multi-level
2.  Editing lists - sorting and renumbering a list
3.  Customise a list style
4.  Apply styles to heading and subheading in a document to generate a table of 

content.

Lists
Lists are simple ways to present text in a way that is easy to scan. Bullet lists, numbered lists, and 
multilevel lists are the types of lists that can be inserted in a word-processed document.

• Bulleted lists are useful for listing items that are related or have similar characteristics.
• Numbered lists are used to record items that must happen in a certain order such as a sequence 

of steps or directions. Numbered lists can also be used to document an order of preference 
or ranking,

• Multilevel lists are lists with more than one level. Examples of 
two multilevel lists are shown in Figure 5.1.

Use multilevel lists when you want to create an outline of items, where 
each item can have its own sub list of items.

Learner Guidance and Tasks
A. Steps for creating a bulleted or numbered list

1. Position the cursor where you want to insert the bullet list.
2. On the Home tab, under paragraph grouping, click the Bullets button to display the bullet 

library (Figure 5.2) OR click on the Numbering button (Figure 5.3).

Figure 5.1: Multilevel lists
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Figure 5.3: Numbering Library

Figure 5.2: Bullet Library

3. Choose a desired bullet or numbering list.
4. Type any text and press Enter key between item items to create the desired list.
5. Press Enter key on the keyboard twice to deactivate the selected bullet/numbering.

Note that numbered lists can be numbers, letters, or roman numerals.

B. Steps for creating a multilevel list

1. Type out the lines of your list, with each item of your list on a 
different line.

2. 
different line.

In the Paragraph group on the Home tab, click the 
Multilevel List button.

3. Choose a list type from the List Library as shown in Figure 5.4.
4. Your list will now be formatted in the style you chose but only 

as a single-level list.
5. On the Home tab, under Paragraph grouping, click the Increase 

Indent button on any item on the list demote that item to a 
lower list level

6. Click the Decrease Indent button on the list item to demote it back to the fi rst level list.

C. How to sort a text/number list

1. Select the list you want to sort.
2. Go to Home tab > Sort button.
3. In the Sort Text dialogue box, set Sort 

by to Paragraphs and Text/ Paragraphs 
and Numbers.

4. Choose Ascending (A to Z) or 
Descending (Z to A).

5. Select OK.

D. How to sort a text/number list

1.  Double-click the numbers in the list. The text won’t appear selected.
2.  Right-click the number you want to change.

Figure 5.4: Multilevel List Library

Figure 5.5: Sort Text dialogue box



52

SECTION 1: MULTIMEDIA TOOLS AND APPLICATIONS

3.  Click Set Numbering value and enter values
These steps are shown in Figure 5.6.

Figure 5.6: Renumbering a list

Task 1

1.  Create a new document in Word.
2.  Save this document using the fi lename ‘Software’. Click on Save or keyboard shortcut (Ctrl + 

S) to effect changes as you work through steps 3 to 5.
3.  Add your name and page number as a footer.
4.  Create two lists:

• A bulleted list of three types of systems software
• A numbered list of the names of at least three examples of application software

5.  Add some pictures to your document to match your chosen software.

E.	How	to	customise	a	list	style	such	as	defi	ning	a	new	bullet

1. Select the text or bulleted list you want to change.
2. On the Home tab, in the Paragraph group, click the arrow next to Bulleted List , and then 

click Defi ne New Bullet.
3. Click Symbol and then select the symbol you want to use.

OR
Click Picture and then browse for your picture from a fi le or Bing Image Search.
Click Insert.
OR
Click Font and then change the font properties to be used for the bullet. You can choose settings 
on the Font tab or the Advanced tab

4. Click OK.

Styles
A Word style is a predefi ned combination of font style, colour, and size that can be applied to any text 
in your document. Styles can help your documents achieve a more professional look and feel. Styles 
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will allow you to apply a consistent look across the whole document instead of having to format each 
section individually, and enables you to quickly generate a table of contents (ToC).

Style sets include a combination of title, heading, and paragraph styles. Style sets allow you to format 
all elements in your document at once instead of modifying each element separately.

F. How to apply a Word style

1. Select the text you want to apply a style to or place your cursor at the beginning of the line.
2. In the Styles group on the Home tab, click the More drop-down arrow (Figure 5.7).

Figure 5.7

3. Select the desired style from the drop-down menu.

Figure 5.8

4. The text will appear in the selected style.
For example, the Title style applied to Computer will give  Computer.

G. How to apply a style set to your document

1. From the Design tab, click the More drop-down 
arrow in the Document Formatting group – see 
Figure 5.9.

2. Choose the desired style set from the 
drop-down menu.

3. The selected style set will be applied to your entire document.

H. How to generate a table of contents from heading styles

1. By default, any text that you apply a Heading 1, 2, or 3 style to will show up as an entry in the 
table of contents. Apply heading styles to the text in a document accordingly.

Figure 5.9
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2. Make sure that you have added page numbers to the document.
3. Position the cursor where you want to insert the table of contents in the document.
4. Go to the Reference tab and click on Table of Contents button from the Table of Contents 

group. Then click on Custom Table of Contents (see Figure 5.10).
5. Format the table of contents, if required.

Figure 5.10

Figure 5.11 Five headings with a Heading 1 style and two headings (internal and portable) with a 
Heading 2 style,

6. T o update a table of contents that was created automatically from heading styles, click References
> Update Table. You can choose to update page numbers only, or select Update entire table to 
update the page numbers and the text (i.e. a change of heading text).

Task 2

1.  Open a previous Word fi le that consists of more than four pages, or open a fi le given by your 
teacher.

2.  Save this document using the fi lename ‘Styles Testing’. Click on Save or use the keyboard 
shortcut (Ctrl + S) to effect changes as you work through steps 3 to 8.

3.  Apply a mixture of Heading 1, 2, and 3 styles to existing heading text. Insert some new 
headings across all the pages.

4.  Insert page numbers in the document if this has not been done previously.

5.  Generate a ToC.

6.  Insert two new pages and add some new heading text to these pages, random text is fi ne.

7.  Apply styles to the new headings.

8.  Update the ToC.
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Task 3

1.  Open a Word fi le from your ICT folder or a fi le given by your teacher.

2.  Save this document using the fi lename ‘Styles Set Testing’. Click on Save or use the
keyboard shortcut (Ctrl + S) to effect changes as you work through steps 3 and 4.

3.  Apply some different styles to your document text from the Styles drop-down menu (shown 
in Figure 5.8).

4. Go to the Design tab and try out different Style Sets (refer to |Figure 5.9).

Pedagogical Exemplars
These examples are only to serve as a guide to the teacher.

Direct instruction: Use screenshots or projections of the Word Home and Design tab ribbons 
to identify the various tools/buttons they will encounter this week. Break down the content into 
manageable blocks for the learners. The order of delivery as given in the Learner Guidance and Tasks 
notes is advised. Using the projector, demonstrate how to do the following:

• Create and edit the three types of lists (bulleted, numbered, and multilevel).
• Apply Word Styles to create a consistent format throughout a document.
• Use the Heading styles to generate a ToC for your document.

Repeat with similar demonstrations if necessary to consolidate learner understanding. Invite directions 
from the learners on the steps to follow during the second or subsequent demonstration(s).

Video-assisted learning (VAL): A couple of the topics covered in this lesson may not be easily 
understood by learners on the fi rst explanation/demonstration. Consider using videos to help with the 
teaching of:

• How to create multi-level lists. A possible video is:
https://www.youtube.com/watch?v=qPqLUxAUvXM Approx. 4 mins

• How to make a ToC from headings:
https://www.youtube.com/watch?v=gxTNbc5WkSQ Approx. 8 mins
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If internet access is unreliable, downloaded tutorial videos could be made accessible to learners to 
reference when completing practical tasks.

Practical sessions and Project-based learning: Engage in practical sessions and project-based 
learning to create and edit lists and apply Styles and Style Sets using word processing software Have 
a number of similar tasks (increasing in complexity, if possible) for the practise of each tool/set of 
tools. The tasks given in the manual could be adapted and expanded to fi t.

Some of these practical tasks could be extending and improving the Word documents produced in 
Weeks 2 to 4. For example, a table of contents could be created for an earlier report. Learners could 
work in pairs on some of the activities, with the teacher choosing the groupings.

Independent learning should be nurtured so that the learners can become confi dent and competent 
digital users. Guidance notes and eManuals/ paper-based manuals on Word should be made accessible 
to learners to refer to when they encounter a problem/forgotten a step. If the internet is available, the 
learners can be directed to online help. Word help & learning (microsoft.com) has excellent easy-to-
follow guides (including videos) on using the various Word 365 tools.

Using experiential learning: In small groups, practically guide learners to explore the focal areas for 
this week such as how to make and edit bulleted, numbered and multilevel lists. Learners could be 
encouraged to further explore the various formatting styles under style grouping in the Home tab. The 
more competent IT users could be challenged to work out how to modify the built-in styles.

Key Assessments
Teachers should assess learners during the learning process. Marks can be assigned to presentations, 
contributions during work, research projects, and more.

The summative assessment questions below are only to serve as a guide for the teacher when creating 
questions to measure learners’ comprehension of the four focal areas for this week’s lessons.

DOK Level 1 (Recall and Reproduction)
1. Complete the sentence: S____________ are a tool in Word that allows the user to quickly apply 

a consistent appearance to their document.
2. A numbered list is

a. an ordered list
b.  an unordered list

3. Point to the tool/button on the Word window that would be used for creating a bulleted list.

DOK Level 2 (Skills and Concepts)
4. Describe two advantages of using the Word styles tool for formatting headings in a document 

over manually setting the formatting for each individual heading.
5. Defi ne a new picture bullet suitable for use with a list of names of players in a football team.

Use the appropriate list tool(s) in Word to create the output shown in Figure 5.12 below

Figure 5.12
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6. a. Create a document that will generate the following table of contents:

 No text need be added to the pages, just the headings.

b.  Insert a new page (page 3) with the heading ‘Communication devices’.
c.  Update the table of contents to show this new page and heading.

DOK Level 3 (Strategic Thinking)
8. A cook is word processing a favourite recipe and is considering which type of list to use for the 

set of instructions. State which type of list that you think would be best used in this situation. 
Justify your choice.

9. What type of page orientation would be best suited to a three-column brochure? Justify your 
choice of orientation.

10. Evaluate the effectiveness of using a word processor to create the following documents:

a. An English essay
b. A birthday card
c. A 3-column brochure
d. A poster to advertise a school dance
e. A music quiz slideshow

DOK Level 4 (Extended Thinking)
11. Investigate the function of the following tool in Word (Layout Tab): 

Use your fi ndings to explain the difference between a Word style set and a Word theme.
12. Since its inception in 1983, Microsoft Word has gone on to become one of the most popular 

offi ce applications in the world. Research the history of Word and create a timeline showing its 
different versions and major functionality extensions over the past 40 + years.
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W   eek 6
Learning Indicator: Create multimedia documents using appropriate computing tools

The notes for this week guide the teacher through introducing Microsoft PowerPoint (Presentation 
software) to learners as an additional computing tool for creating and presenting a multimedia 
document. It fi ts with the learning outcome for this section:

Theme/Focal Areas:

1.  Basic	fi	le	handling	in	PowerPoint:	creating	a	new	presentation,	saving	a	
presentation, opening an existing presentation, and printing a presentation.

2.  Inserting new slides, text, and graphics
3.  Applying a design template to slides
4.  Playing a slideshow

What Is Presentation Software?
Presentation software is a computer program that is used to present information, normally in the 
form of a slideshow. The software will include three main functions: an editor that allows text to be 
inserted and formatted, a method for inserting and manipulating multimedia (graphic images, video 
and sound) and a slideshow system to display the content, usually with the facility to add animations 
and transitions. Two examples of presentation software are Microsoft PowerPoint (part of the Offi ce 
suite) and Apple Keynote. All the instructions and screenshots in this manual are for PowerPoint 365.

Before learners can begin using the many features of PowerPoint properly, they will need to know 
several basic skills and concepts. Identifying the parts of the PowerPoint screen components, creating. 
opening and saving a document, and moving around within it are the foundations to build on. Many 
of the tools in PowerPoint match those in Word and work in the same way. First of all, however, it 
is important to establish which version of PowerPoint is being using. This will help the teachers and 
learners to choose the correct paper-based or online manuals which they can reference to expand their 
digital presentation skills.

Establishing PowerPoint Version
Create a new blank presentation 
or open an existing PowerPoint 
presentation.

Choose File from the top left 
corner, and then click either 
Account or Help on the left 
navigation bar. You will 
see your Offi ce version and 
information under Product 
information, on the right side 
of the window.

Figure 6.1: Checking PowerPoint version
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Parts of the PowerPoint Window

Being familiar with the names of the various parts of the PowerPoint window and their function(s) 
is very useful and will be necessary for learners to know when following the guide instructions for 
this week.

Figure 6.2: PowerPoint Window

Title bar: Displays the document name followed by a program name
Quick Access toolbar: Contains buttons for commonly-used commands.
Tabs: Contain groups of commands organised by function
Ribbon: Contains buttons and options for the selected tab
Slide pane: Displays the current slide
Slides/Outline pane/slide thumbnail list: Shows a thumbnail or an outline of the slides
Status bar: Displays slide position, design, and other information
Scroll bars: Allow you to navigate through the slides
Slide title placeholder: Title of the slide is typed here.

As illustrated in Figure 6.2, the PowerPoint window has similar features and layout to the Word window.

Most of the features of different versions of PowerPoint will match or be similar, but there will be 
differences.

Figure 6.3: PowerPoint 365 Home Ribbon
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Figure 6.4: PowerPoint 2010 Home Ribbon

Learner Guidance and Tasks
Basic	fi	le	handling	Guidance

A. How to launch Microsoft PowerPoint, create and save a new presentation

1.  Click on the Start icon ( ). It will be located in the bottom-middle or bottom-left corner of 
your screen.

2.  Type PowerPoint in the search bar and click on the Microsoft PowerPoint app that appears in 
the search results

4.  Click Blank presentation to open a new blank presentation window as shown in Figure 6.5.

Figure 6.5

1. Click on Save As command (or Save a Copy if using PowerPoint 365)
2. Make necessary changes in the Save As dialogue box.
3.  Click Save.
4. Add content to the title and subtitle on in the slide 

pane by fi rst clicking on the placeholders.
5. Add more slides if required (see instruction set B).
6. Click on Save regularly to update the content of the 

last stored fi le. Figure 6.6: Default fi rst slide type
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7. Click on the X in the top right-hand corner of the PowerPoint window or select File > Close. 
You may be prompted to save again at this point.

Use Save As when saving a document for the fi rst time. It is good practise to save the blank presentation 
using an appropriate fi le name and folder before you start entering content. Use File > New when 
starting a new presentation from within PowerPoint.

B. How to insert a new slide

1. Select the slide you want your new slide to follow.
2. Select Home > New Slide – see Figure 6.7.
3. Select a slide layout.
4. If Blank is selected, the user will 

have to insert a textbox to enter text. 
5. Click on the placeholder and enter the content.
6. This is the slide layout you 

will need for most of the 
tasks in this manual: 

C. How to delete a single slide

1.  Right-click the slide in the thumbnail pane/list on the left.
2. Select Delete Slide.

D. How to open an existing slideshow for editing

1. Click on the File Explorer icon. [ ]
2. Go to the folder location where your fi le is stored.
3. Open the document you wish to edit by double-clicking on it.

From within PowerPoint, the steps would be:

1. Click the File tab.
2. Click Open. The Open screen appears, select/browse a location, and select the fi le you 

want to open.

E. How to print from PowerPoint

1. Select File > Print.
2. To preview each slide, select the 

forward and backward arrows at the 
bottom of the page.
If the text is too small to read, enlarge using the zoom slider at the 
bottom of the page.

3.  Choose the number of copies, and other options you want. Check 
that the correct printer is selected and online. Printer properties
will give you additional options. elect the Print button.

Figure 6.7: New Slide pull-down menu

Figure 6.8: Print dialogue box
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F.  How to play a PowerPoint slideshow

1. On the Slide Show tab in the Start Slide Show group, select From Beginning as shown in 
Figure 6.9.

Figure 6.9

2. Left click on the mouse or press N on the keyboard to move to the next slide.

Task 1

1. Create a new presentation and save it using the fi le name ‘Myself’

2. Add the text ‘All About Me’ as the title and your own name as the subtitle.

3. Use the tools from the Font group (Home tab) to format the entered text as you wish.

4. Save your updated document.

Task 2

1.  Open the fi le saved in Task 1 (Myself.pptx).

2.  Insert a Text and Content slide.

3.  Enter ‘My Family’ as the title, and enter some details about your family in the content area.

4. Add at least four additional slides about yourself, leaving room for pictures that you will be 
adding later. Three of these titles should be:

• My Favourite Things
• My School
• My Hopes for The Future

5. Format your text to make it more visually appealing.

6. Play you slideshow and check for errors.

7. You may wish to experiment with adding transitions and animation to your slideshow:

• Slide transitions are the animation-like effects that happen when you move from 
one slide to the next during a presentation. Experiment with the options given in the 
Transition tab.

• Animation or movement on a slide can be used to draw the audience’s attention to 
specifi c content or to make the slide easier to read. In PowerPoint, you can animate 
text and objects like clip art, shapes, and pictures. Select the object to be animated and 
experiment with the options given in the Animations tab.

8. Save your updated document.
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G. How to apply a design template

A template is a pattern or blueprint of a slide or group of slides).

1. Click the Design tab on the ribbon.
2. Click the design you want from the Themes group – see Figure 6.10.

Figure 6.10

The design is applied to the presentation.

Task 3

1.  Open Myself.pptx.

2.  Apply a design template theme of your choice to your slideshow.

3.  Save your updated slideshow.

Inserting Graphics Guidance

H. How to add basic shapes to a slide

1. Go to the slides pane in the PowerPoint window
2. On the Insert Tab under the Illustrations group, click on shapes and pick a shape
3. Drag the cursor using the mouse to enlarge the shape
4. Select the shape and use the tools from the shape format menu to format its appearance 

as you wish.

Figure 6.11: Inserting shapes
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I.  How to add pictures to a slide

1. On the Insert tab under the Image group, click on Pictures – see Figure 6.12
2. Then do one of the following:

• Click This Device for a picture on your computer.
• Click Stock Images for high quality images or backgrounds.
• Click Online Pictures for a picture on the web.

3. Select the picture you want, and then click Insert. Your picture will be inserted – see Figure 6.13.
4. Use the tools in the Picture Format tab to format and edit the picture.

Figure 6.13: A slide with a title and an inserted picture

Task 4

1.  Open Myself.pptx.

2.  Insert pictures and shapes to your slides to match the text.

3.  Format these graphics

4.  Save your updated slideshow.

P    edagogical Exemplars
These examples are only to serve as a guide to the teacher.

Direct instruction: Use screenshots or projections of the 
PowerPoint Home ribbon and other targeted ribbons to identify 
the various tools/buttons learners will be using this week. Break 
down the content into manageable blocks for the learners. The 
order of delivery as given in the Learner Guidance and Tasks notes 
is advised. Using the projector, demonstrate how to use the skills 
given in the three focal areas. Repeat with similar demonstrations if 
necessary to consolidate learners’ understanding. Invite directions 
from the learners on the steps to follow during the second or 

Figure 6.12
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subsequent demonstration(s). Continue to remind learners about to practise good fi le management at 
all times.

Practical sessions and Project-based learning: Engage in practical sessions and project-based 
learning to create slideshow using presentation software. Have a number of similar tasks (increasing 
in complexity, if possible) for the practise of each tool/set of tools. The tasks given in the manual 
could be adapted and expanded to fi t.

Independent learning should be nurtured so that the learners can become confi dent and competent 
digital users. Guidance notes and eManuals/ paper-based manuals on PowerPoint should be made 
accessible to learners to refer to when they encounter a problem/have forgotten a step. If the internet 
is available, the learners can be directed to online help. Microsoft has excellent easy-to-follow guides 
(including videos) on how to use various PowerPoint 365 tools:

https://support.microsoft.com/en-us/powerpoint

digital users. Guidance notes and eManuals/ paper-based manuals on PowerPoint should be made 
accessible to learners to refer to when they encounter a problem/have forgotten a step. If the internet 
is available, the learners can be directed to online help. Microsoft has excellent easy-to-follow guides 
(including videos) on how to use various PowerPoint 365 tools:

https://support.microsoft.com/en-us/https://support.microsoft.com/en-us/powerpointpowerpointhttps://support.microsoft.com/en-us/powerpointhttps://support.microsoft.com/en-us/https://support.microsoft.com/en-us/powerpointhttps://support.microsoft.com/en-us/

Using experiential learning: In small groups, practically guide learners to explore the focal areas 
for this week such as how to create and play a basic presentation consisting of text and graphics. 
Learners could be encouraged to explore other PowerPoint tools. The more competent IT users could 
be challenged to work out how to insert hyperlinks, video and sound into their presentations.

Learner-led presentations: When a learner or group has produced an interesting or high-quality 
presentation, give him/her/them the opportunity to present their slideshow to the class, followed by a 
Q&A session about the computing tools employed.

Ke y Assessments
DOK Level 1 (Recall and Reproduction)

1. PowerPoint is an example of

a. word processing software
b. presentation software
c. graphics software

2. What is the keyboard shortcut for the italic font style in PowerPoint?
3. PowerPoint can be used to create a multimedia document. List at least two type of media that 

can be inserted into a PowerPoint slide.
4. Demonstrate entering a given title and subtitle to a PowerPoint slide.
5. docx is a fi le format used for PowerPoint fi les.

a. True
b. False

6. Select all the possible applications of PowerPoint as the most appropriate software from the 
following list:

a. A teacher to create slides for use in his/her lessons
b. An artist to create a collage
c. An accountant to keep fi nancial records
d. A student to type up an English essay
e. A fi lm maker to edit video
f. A lecturer to convey key concepts to his/her tutor group
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DOK Level 2 (Skills and Concepts)
7.	 Demonstrate how to insert different types of shapes (e.g., rectangles, circles) into a 

presentation slide.
8.	 Analyse the impact of applying different formatting options to text on a slide.
9.	 Explain the process of inserting a ‘Title’ slide into a presentation.
10.	 Create a four-slide presentation from a given storyboard.

DOK Level 3 (Strategic Thinking)
11.	 Evaluate the effectiveness of using shapes to visually enhance key points in a presentation.
12.	 Apply a cohesive visual theme to the slideshow created in 9 above.
13.	 Design and create a quiz on the content of the SHS 1 ICT course so far. Test this quiz on your class.
14.	  Create a concept map of the topics covered in Section 1 of the SHS 1 ICT course.
15.	 Evaluate the impact of the placement of photos to complement textual content on audience 

engagement.

DOK Level 4 (Extended Thinking)
15.	 Design and create an interactive presentation that utilises advanced multimedia elements, such 

as 3D shapes or embedded videos.
16.	 Investigate the uses of the Record tab tools in PowerPoint. Create a slideshow that summarises 

the results of your investigation.
17.	 Conduct research on the benefits of AI-powered tools such as ChatGBT for creating presentations. 

Compile a list of links to useful websites and online videos on this topic.

Section Review
This section has focused on equipping learners with the use of ICTs in the society with emphasis 
on organising, managing and presenting information using productivity tools. Learners will 
appreciate the relationship between hardware and software components of a computer system. 
By the end of the six weeks, learners should be able to describe the software and hardware 
needed to create a multimedia document, and have developed some basic skills in Word and 
PowerPoint. The teacher will have guided learners to articulate and record the relationship 
between the software and hardware components of a computer system, and how they are used in 
creating multimedia documents. Learners will have produced a variety of multimedia document 
which will have honed skills that can be used in other subject areas,

The ability of learners to master the content of this section of the SHS1 ICT course will equip 
learners with valuable digital literacy and creativity skills, that will position them well in today’s 
technology-driven world.
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SECTION 2: DIGITAL DEVICES- EXAMPLES AND 
IMPORTANCE

Strand: ICTs IN THE SOCIETY

Sub-Strand: Emerging Technology and Applications

Content Standard: Demonstrate knowledge and understanding of Emerging Technologies

Learning Outcome:Explain and apply digital and Social Media platforms

INTRODUCTION
This section aims to improve and expand the learners’ understanding of the use of ICTs in society. 
The main focus of Week 7 to 10 will be an examination of many current and some emerging IT 
technologies. Learners are expected to be able to identify and describe the purpose and uses of a range 
of digital devices. An exploration of these devices will lead to an examination of related topics such 
as smart technology, wireless connectivity and the link between the growth in the use of smartphones 
with the transformation of social media.

An outline of the work covered in this four-week section

Week 7: Explain digital devices and their importance.

Week 8: Differentiate between desktops, laptops, smart gadgets (tablets) and servers.

Week 9: Explore the purpose and uses of smartphones, digital cameras, wearable devices and 
games devices.

Week 10: Explore the purpose and uses of e-book readers, and portable and digital media players. 
A further examination of smart devices and related topics (wireless connectivity, Internet of Things), 
and the link between smartphones and social media platforms.

SUMMARY OF PEDAGOGY
This section considers a variety of teaching and learning approaches, strategies and techniques. 
These include hands-on activities where learners engage in practical activities to research, explain 
and demonstrate. Where appropriate, learners should be offered the opportunity to work in groups to 
find solutions to assigned tasks.

Experiential learning activities with mixed ability/mixed gender groupings should dominate the 
lessons in this section. All learners, irrespective of their learning abilities should be encouraged to 
participate fully in lessons. And, of course, make considerations and accommodations for the different 
learning styles. Offer below average/approaching proficiency learners the opportunity to make oral 
presentations when it is deemed fit, and provide more challenging extension activities for the above 
average/highly proficient learners. Practical sessions and project-based learning will increase learner 
engagement, foster valuable collaboration and teamwork skills and provide opportunities to practise 
their word processing and presentation skills introduced in Weeks 2 to 6.

Brainstorm, brain write and discuss will have a place, in particular when introducing topics or during 
plenary sessions. Allowing the learners to use a digital device and examine its functionality up 
close is the ideal. However this will not be possible for most of the devices covered in this section. 
Videos and animations showing those digital devices which are not at hand are a valuable alternative. 
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Footage of devices being used in real-life settings can help cement a better understanding of their 
features and uses.

SUMMARY OF ASSESSMENT
The assessment (formative and summative) section takes into consideration all four levels in the Revised 
Bloom’s Taxonomy. Level 1(Recall/Reproduction), Level 2 (Skills/Conceptual understanding), Level 
3 (Strategic Thinking/ Reasoning), and Level 4 (Extended Critical Thinking and Reasoning). There 
are assessment suggestions that can fit to different levels of ability - learners approaching proficiency 
(AP), proficient (P) learners and highly proficient (HP) learners. Apart from the traditional form of 
practical and written tests and assignments, assessment in this section can include many other forms. 
These include demonstrations of using a digital device, mind maps or concept maps, multiple choice 
quizzes, group projects, self-assessments, oral presentations, peer review, portfolios, debates, game-
based assessments, digital storytelling and matching tasks.

Please note that the key assessment items in this manual are only to serve as a guide for the teacher 
to establish learners’ understanding of the course material. They do not in any way limit the teacher 
from exploring and creating his/her own questions.
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We ek 7
Le arning Indicator: E xplain digital devices and their importance

T heme/Focal Areas:
1.  What is a digital device?
2.  Why are digital devices important?
3.  Digital technologies in education

Analogue and Digital
An analogue signal is a continuously changing signal and an analogue device is one in which the 
data is transferred in a continuous wave. Examples include traditional clocks and dimmer switches. 
A digital signal on the other hand is an ‘on’ or ‘off’ type of signal with no in-between. Digital signals 
are a series of pulses with two states represented by 1s and 0s.

Figure 7.1: Analogue signal and clock, and digital signal and clock

What is A Digital Device?
A digital device is a piece of electronic equipment that can create, generate, send, share, communicate, 
receive, store and display digital data. Digital devices translate information into binary format (zero 
or one) but analogue devices translate information into electric pulses of varying amplitude. Digital 
devices are more accurate, store data more effectively, and handle larger amounts of data than 
analogue devices. Examples of digital devices include personal computers, digital clocks, gaming 
consoles and smartphones.

Why Are Digital Devices Important?
The reasons that digital devices are important are many and can vary depending on how and where 
the devices are being used. The reasons for their importance includes:

• They can quickly process data for a variety of purposes.
• They are able to provide quick access to information.
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• They are compact, faster, lighter and more versatile than non-digital devices.
• They are able to store and move huge amounts of information locally or remotely and move it 

around virtually instantaneously.
• They are able to automate tasks.
• They can work 24/7.
• They are able to break down distance barriers and allow people from different parts of the world 

to communicate instantly.

Digital technologies have transformed nearly every aspect of modern life. Education, travel, work, 
shopping, entertainment, and communications are just some of the areas that have been revolutionised 
in recent decades by these technologies. These technologies have helped save people lots of time and 
money in their personal and work lives by automating tasks, improving connectivity and saving them 
from having to travel as much.

Figure 7.2: Some areas where digital devices are commonly used today

YouTube Video link: https://www.youtube.com/watch?v=ZDzjqmU43Vw

How Has Technology Made Our Lives Easier? (4 mins)

Digital Technologies in Education
Looking closer at the effect of digital devices on education will reveal a long list of benefi ts, including:

●	 Increased student engagement
●	  Access to a vast range of interesting and up-to-date resources
●	  Improved lesson plans for teachers
●	  Personalised learning
●	  Building essential 21st Century skills
●	  Increased scope for distance learning

YouTube Video link: https://www.youtube.com/watch?v=oDAkGCsTsyA

Possible Benefi ts of Using Technology In Education (1 min):
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What is Digital Learning?
Digital learning is any kind of learning that employs digital technology. It generally involves the use 
of computers and often the use of the internet. Some examples of digital learning are:
●	 Classroom technologies using specialist software and hardware, and the internet
●	 Online tutoring
●	 E-textbooks
●	 Social media
●	 Multimedia
●	 Online games
●	 Mobile phones
●	 Audio podcasts

Nowadays, educators/teachers and learners can access a vast array of online resources.

Figure 7.3: A slideshow on Twinkl that can be downloaded

For example, Twinkl, an online educational publishing house based in the UK, has a large selection 
of engaging learning materials including materials that could be used in ICT courses:
https://www.twinkl.co.uk/teaching-wiki/ict-information-and-communication-technology

What is the difference between digital learning and e-learning?
Digital learning involves the use of digital devices to facilitate learning, regardless of whether the 
students and the teacher are in the same room or not.

E-learning is a type of digital learning that is a fully online learning experience, which means that 
the practise is remotely done. The learner and educators are in different places and can communicate 
through online tools and platforms.

Increasingly, in many parts of the world, schools are now using e-learning in order to complement the 
learning that is done in the classroom. For example, homework may be set online. Blended learning
is the term used to describe the use of various combinations of traditional face-to-face learning 
experiences with online technologies.
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Recent acceleration of digital learning
The COVID-19 pandemic created the most significant disruption of education systems in human 
history, affecting it is estimated nearly 1.6 billion learners in more than 200 countries. Closures of 
schools, institutions, and other learning spaces due to COVID-19 impacted more than 94% of the 
world’s student population. During the periods of lockdown, digital learning became the only option 
to continue education. While digital technologies had infiltrated the world of education prior to 2019, 
the pandemic has led to a significant increase in their usage at all levels of education.

Advantages of Digital Learning
These include:

1.	 Personalised learning: Digital learning can help enable personalised learning in that everybody 
has specific techniques and learning methods that suit them. Digital learning can help students 
and teachers get a better understanding of the most suitable teaching and learning methods for 
them, helping the delivery of lessons/lectures and learning to be more effective. It can also often 
give the student the opportunity to work at a pace that works for them. Digital technologies 
have facilitated additional teaching and learning strategies including ones to improve learner 
accessibility such as screen readers.

2.	 Improved learner engagement: Different types of multimedia such as images, audio, and video 
can now be easily incorporated into course materials. Using digital devices in the classroom or 
at home can help turn learning traditionally dull subjects into interactive and fun experiences.

3.	 Increased learner access to materials: Using the internet and/or portable storage media, 
learning resources can be available to students—24 hours a day, 7 days a week. This gives 
students complete flexibility over when and where they study, enabling them to take control 
over the best times to focus on learning as well as how much to learn at each time, and access to 
a global community. Lectures and seminars are sometimes recorded and uploaded so that note-
taking can be kept to a minimum during timetabled lessons and you can always replay what 
was said. With digital learning, student have greater opportunity to maximise their learning, and 
to go over subjects that they find more challenging as well as get extra information relating to 
subjects that they wish to improve understanding.

4.	 Cost saving education: There are many e-learning courses available that can be accessed and 
completed free, all from the comfort of your own home with no travel required.

5.	 A wide variety of learning tools: As much of digital learning is usually done using personal 
computers or tablets, there are more opportunities of creating backups of the work that you have 
completed. You can save files locally on your computer, or you can upload these to a cloud-
based storage. This usually means that you can also retrieve your files on multiple devices no 
matter where you are. There are many software features to help learners. For example, if you 
are word processing your essays or reports, the spelling and grammar check tool will spot and 
help fix any spelling or grammatical errors.

6.	 Facilitates collaboration: Students and teachers can easily share documents over a school 
network or via the internet.

Disadvantages of Digital Learning
The biggest disadvantage of digital learning is the digital divide. When we talk about the digital 
divide, we are referring to the percentage of people who have access to the internet and digital devices 
and the percentage of those who do not. Digital learning is not an option for those who have no access 
to either an internet connection or a computer or mobile phone.



74

SECTION 2: DIGITAL DEVICES- EXAMPLES AND IMPORTANCE

Figure 7.4: A gap exists between those who have affordable access, skills, 
and support to effectively engage online and those who do not

Digital learning requires the use of a digital device. For some families access to digital devices is 
not always possible. Many families only have access to one shared digital device such as a desktop 
computer. Some do not have any computers at all and the monthly cost of an internet connection is 
a luxury that they forgo. The cost of software such as word processing or spreadsheet programs can 
sometimes be prohibitive. Fortunately, some companies provide these resources in-browser for free, 
but often not with full functionality.

Learning materials for e-courses are sometimes distributed on CD-ROMs or fl ash drives, but generally 
these materials must be downloaded from the internet. Internet reliability and speeds can vary between 
countries and locations. You may also fi nd that only slower internet connections are available in 
rural areas.

People who are enrolled in e-learning courses must have some level of digital literacy for them to 
be able to complete their studies successfully. Learners are often required to join video calls (which 
require webcams, microphones and speakers) as well as sending emails or uploading work. For those 
unfamiliar with using a computer or the internet, this could have a profound impact on how easily 
they can follow the materials and contribute to the lessons.

Internet usage in Africia
As of January 2024, Nigeria had more than 103 million internet users - the highest number reported 
all over Africa. Meanwhile, Ghana ranked sixth with over 24 million users – Figure 7.5.

Figure 7.5: Top 11 Internet users in Africa as of January 2024, by country(in millions)
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Some teacher resources and recommendations for digital learning

There are many resources available to support teacher implementation of digital learning. These include:

●	 Word processing software such as Word to create learner notes and workbooks
●	 Presentation software such as PowerPoint for lesson slides
●	 Blended learning platforms such as MS Teams and 

Google Classroom
●	 Online flashcards
●	 Game design software
●	 Interactive whiteboards
●	 Online quizzes and educational games

Fun Ways to Promote Digital Learning
●	 Create a computer club at school or outside it to investigate all kinds of new electronics and 

gadgets that could be used in the classroom.
●	 Try out fun online educational resources (e.g. Scratch, Quizlet) to make learning 

interactive and fun.
●	 Challenge learners to look into the history of recent technological advancements. Computers 

only made it into schools in the early 1980s, and even then, they did not have the range of 
options available to us today.

●	 Introduce your learners to game design and have them invent and promote their own educational 
game. There are plenty of programs to help them learn how to do this, and it would be a great 
group project in class.

Conclusion
The nature of learning has changed significantly in more recent years. As with most things in our 
society, digital technology has been the catalyst in this significant change. Digital technologies have 
improved learning both in terms of the engagement with students and the effectiveness of teaching, 
resulting in better results for students. Digital technologies will continue to evolve and impact 
education. The full impact of Artificial Intelligence (AI) in education remains unclear at this juncture. 
However, it is expected to bring further changes; these include increased personalising learning 
experiences, further automation of administrative tasks, extending and improving accessibility, and 
providing more real-time feedback to both students and teachers.

Learning Tasks

Here are some tasks/activities to help learners gain an understanding of digital devices and 
their importance in everyday life.

The teacher should differentiate the tasks to suit the proficiency levels of the different learners.

Brainstorm Tasks

Session topics

1.	 The names of digital devices.

2.	 The digital devices from session 1 that could be used in a given list of scenarios (for example, 
used by an author when writing a book).

 

Figure 7.6:  Two popular blended 
learning platforms used in schools
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3.	 Apart from education, what areas of society now rely heavily on the use of digital devices?

4.	 The benefits of the use of digital devices in a given area of society (for example, in medicine).

Think-Pair-Share Tasks
Questions for discussion:
•	 How can digital learning impact teaching in a High School?

•	 How can digital learning impact learning in a High School?

•	 Is digital learning more suited to the teaching and learning of certain subjects? If so, which 
subjects?

•	 What are the advantages of blended learning over traditional learning?

Practical Tasks (individually or in groups)
1.	 Choose at least one sector of society from Travel, Retail, and Banking. Research and create 

a slideshow under the following headings: Digital devices used in < sector name>, Uses of 
the digital devices in <sector name>, Why digital devices are important in <this sector>?. 
Include images in your slideshow. Each group should present their slides to the whole class.

2.	 Explore the uses of Scratch as a learning tool other than a tool to learn programming. (https://
scratch.mit.edu/)

3.	 Create a concept map on the possible benefits of digital technology in education.

Pedagogical Exemplars
These examples are only to serve as a guide to the teacher.

Whole class discussion: For example, have an open discussion on the meaning of digital and analogue, 
and the difference between these two terms. This will lead nicely to the definition of a digital device.

Brainstorm: As a whole class or in mixed-ability/mixed-gender groups, the learners should engage in 
a number of brainstorm sessions at appropriate times throughout the week. For example, brainstorm 
the digital devices found in their school.

Direct instruction: The teacher goes through the main focal areas using a slideshow, giving accounts 
of his/her personal experiences relating to digital learning.

Video-assisted learning (VAL): There are a vast number of suitable online videos that could be 
incorporated into lessons such as the one shown in the YouTube video screenshot.

Think-Pair-Share: The teacher poses a number of questions relating to the focal areas. Learners 
think individually about the answers before sharing with a learner beside them (pair).Each pair group 
then share their chosen response with the whole class.

Individual or collaborative practical project: Some ideas are listed in the Learner Tasks.

Online learning: Pupils sign up for a free online course from home (for example an introduction to 
Python programming course at Khana Academy (https://www.khanacademy.org/computing/intro-to-
python-fundamentals), or research a topic from home using weblinks given by teacher (for example 
cyberbullying at https://saferinternet.org.uk/guide-and-resource/young-people/resources-for-11-19s)
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How has technology made our lives easier?

Key Assessments
Teachers should assess learners during the learning process. Marks can be assigned to presentations, 
contributions during work, research projects and more.

The summative assessment questions below are only to serve as a guide for the teacher when creating 
questions to measure learners’ comprehension of the three focal areas.

DOK Level 1: Recall/Reproduction.
1. Complete the sentence:

A digital device handles data in the form of ___’s and ___’s.
2. List 3 examples of a digital device that you may fi nd in a classroom.

3. Which of the following are analogue?
a. sound
b. pressure
c. temperature
d. an ordinary light switch
e. a dimmer light switch
f. time

4. Complete the defi nition:
E-learning refers to online learning experiences that can be accessed through a ________________

5. Digital learning and e-learning are the same.
a. true
b. false

6.  State two benefi ts of digital learning over traditional learning.
7. How do digital devices help us in our everyday life?
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8.	 How has the use of digital devices changed the way we communicate?
9.	 Use the words digital and analogue to correctly label the following signal waveforms:

Signal

Signal

DOK Level 2: Skill/Concept
10.	 Describe what features a piece of physical equipment would require to classify as a digital device.
11.	 Describe two advantages and two disadvantages of using digital media in teaching and learning 

in high school.
12.	 Name three digital devices that would be found in a typical office and describe some day-to-day 

uses of these devices in this environment.
13.	 Explain what is meant by the term ‘Digital Divide’.
14.	 Describe three ways that the use of digital devices have improved productivity in the workplace.

DOK Level 3: Strategic Thinking
15.	 Zuhrah wants to complete an e-learning course on web design. What will Zuhrah need to 

complete this course?
16.	 Research the importance of digital devices in the entertainment sector. Present your findings in 

a multimedia slideshow.
17.	 Evaluate the impact of digital device usage on personal privacy.
18.	 Propose a plan to integrate digital devices into a traditional classroom setting.
19.	 What does the increase in digital device usage indicate about modern communication trends?
20.	 ‘Digital devices are important to society.’ ‘Digital devices provide many benefits to society.’ 

Discuss how these two statements compare and contrast.

DOK Level 4: Extended Thinking
21.	 Imagine you are the manager of a travel agency. Create a survey on paper or online 

(SurveyMonkey - Free online survey software and questionnaire tool) to assess how the use of 
digital devices has improved the job satisfaction of your employees.

22.	 Investigate what steps the Ghanaian Government are taking to bridge the Digital Divide gap.
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Week 8
Learning Indicator: 	Differentiate between desktops, laptops, smart gadgets(tablets), and servers.

Theme/Focal Areas: 
1.	 Describe the main features of the digital devices: personal computers (desktops, 	

laptops, tablets), servers and smart gadgets.
2. 	 Identify differences between the digital devices listed in Focal Area 1.

Personal Computers
A personal computer, often referred to as a PC, is a computer designed for individual use. There are 
several types of PCs, including desktops, laptops, tablets and smartphones.

2 3
41

Figure 8.1 Examples of PCs

Desktops – see 1 in Figure 8.1
A desktop computer is a type of computer intended for regular use at a single location (desk/table) 
due to its size and power requirements (mains power only). In modern desktops, the input devices 
(such as keyboard and mouse) and the output devices (such as screen/monitor) are separate from 
the system unit/tower (the case that contains the processing circuitry). The internal storage devices 
are a hard drive and maybe an optical disk drive. Nowadays, desktops will have built-in wireless 
communications capability.

Desktops are a suitable option if you work mostly in one place and have plenty of space. With 
the correct hardware (including a network interface card), desktops can become workstations on 
a network.

Laptops -– see 2 in Figure 8.1
A laptop, also called a notebook computer, is a thin lightweight mobile computer. It is designed to fit 
on your lap and to be easily transported. It can operate both on batteries and on a mains power supply. 
Ultra thin laptops weigh less than traditional laptops, and usually have a longer battery life. Laptops 
have built-in input devices such as a keyboard, touchpad and webcam, and built-in output devices, 
such as a screen and speakers. Some laptops have touch screens. The internal storage devices are a hard 
drive and maybe an optical disk drive. Nowadays, laptops will have built-in wireless communications 
capability. A convertible laptop, also known as a 2-in-1 laptop, is designed to function as both a 
laptop and a tablet. It has flexible hinges to allow the keyboard to fold away from the screen or spin/
swivel to act as a tablet stand.
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Figure 8.2: A convertible laptop

Laptops are designed for personal use and can perform similar functions to desktops, such as browsing 
the internet, creating documents, and playing games. With the correct hardware (a network interface 
card), laptops like desktops can become workstations on a network. As laptops are generally smaller 
in size than desktop computers and are battery powered, they are suited for work use on the move 
such as business trips. Laptops allow employees to stay in touch with their employer using email and 
video chat while having files, software and data readily at hand.

Tablets -– See 3 in Figure 8.1
A tablet is a thin, lighter weight mobile computer that has a touch screen. It is usually smaller in size 
than laptops but larger than a phone. As an alternative to interacting with the touchscreen, a separate 
physical keyboard can be purchased that attaches to or wirelessly communicates with the tablet. Like 
a laptop, a tablet can run on batteries or mains power.

Two popular form factors (shapes and sizes) of tablets are the slate and convertible. A slate tablet 
is the classical form of tablet with a touch screen and no keyboard. It can be operated with a stylus 
or fingers, and can be held like a clipboard. A convertible tablet is a tablet that has a screen with a 
lid and a keyboard in its base, with the lid and base connected by a swivel-type hinge. You can use 
a convertible tablet like a traditional laptop, or you can rotate the display and fold it down over the 
keyboard so that it looks like a slate tablet.

Tablets are useful for taking notes in class, at meetings or at conferences. Slate tablets can have a 
more durable construction so they are often used in the medical field and other areas where exposure 
to germs, heat, humidity, dust and other contaminants is greater.

Servers
Server computers are the lifeblood of any client-server network by enabling the network to function. 
In essence, they ‘serve’/provide services to network users (who are generally referred to as ‘clients’). 
These services include file storage, web hosting, application storage, and database management. For 
example, when you log on to a school or work network, a logon server will check that you have a 
valid account. Then the file server will connect you to your user area and any other storage areas such 
as the student shared area. A school or company’s website is stored on a web server and email comes 
from an email server.
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Figure 8.3: A possible layout of a client/server network

So, servers on a network provide services to clients, while computers connected to a network 
(workstations) request services from servers. Servers are designed to handle many requests, while 
workstations are designed to be used by one user at a time. Servers also differ from regular computers 
in their specifications: typically more powerful, with more RAM and reliable power sources.

Smart Gadgets
Other than being less formal, the word ‘gadget’ is interchangeable with ‘device’ when referring to 
a physical object. A smart gadget or smart device is an electronic device that uses the internet to 
connect to and communicate with other devices or networks to complete a task or solve a problem. 
They are often designed to perform specific tasks with improved efficiency and convenience. Smart 
gadgets have become an integral part of our lives, offering a multitude of benefits that enhance our 
daily routines.

Examples of smart gadgets include:
•	 Smart speakers
•	 Smartphones
•	 Smartwatches
•	 Smart TVs
•	 Smart lighting systems
•	 Smart thermostats
•	 Smart security cameras and systems
•	 Smart kitchen appliances e.g. smart refrigerators

One definition of a smart device is: “any computer-controlled electronic apparatus that is not a 
desktop, laptop or tablet computer, which are technically ‘intelligent’ devices”. However, while 
some books and websites refer to a tablet as a smart gadget a more common way to classify a tablet 
is as a PC.

Week 9 notes are devoted entirely to the study of smart devices/gadgets. We will start by having a 
closer look at smart speakers.
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Smart speakers
Smart speakers are connected to a Wi- Fi network and operate via voice commands. They are capable 
of streaming audio content, relaying information, and communicating with other devices.

Figure 8.4: Examples of smart speakers

Differences Between Computer Types

Differences between desktop computers and laptop computers
1.	 Desktop computers are not portable and run only on a mains power supply but laptop computers 

are portable and can run on battery and a mains power supply.
2.	 Desktop computers need external devices to be fully functional and are large in size but laptop 

computers are all-in-one computer systems and are smaller in size when compared to a desktop.
3.	 Desktop computers can have multiple internal drives whilst laptop computers have limited 

internal drives.
4.	 Desktop computers require external input devices such as the keyboard and mouse to be 

connected for input but laptop computers have keyboard and mouse in-built.
5.	 The cost of purchase and maintenance of a desktop computer is generally less than the cost of 

purchase and maintenance of a similar spec laptop computer.
6.	 Desktop computers can easily be upgraded as the components are removable but in laptop 

computers upgrades are not as easy or not possible.
7.	 Desktop computers generally consume more power than laptop computers.

Comparing the given four types of computers
Using the previous descriptions and further research, comparisons between any two of the four 
computer types can be documented. This would be a suitable activity to complete the study of Focal 
Area 2. The comparisons could take the form of a list but a tabular layout with given criteria, as outlined 
below (for desktop and server computers), is recommended. The entries could be very general such 
as slower and much more powerful for processor or be more technical and include typical number of 
cores and clock speeds.

Desktop Server
Portability
Form factor
Processor
Internal storage
Peripheral devices
Typical uses
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Typical user
Cost
Image

The above table could be used to compare two computer types at a time. An additional one or two 
columns could be added to broaden the comparison in an activity.

Learning Tasks

Here are some tasks/activities to help learners gain an understanding of the different types of 
computers and the differences between them.

The teacher should differentiate the tasks to suit the profi ciency levels of the different learners.

Group Tasks
1. Where there are available resources (digital devices such as PCs and internet access) divide 

learners into small groups. Assign each group a specifi c sector of society to research that 
uses computers. These areas could include communication, education, entertainment, health, 
and business. Ask them to summarise the results of their research under various headings 
such as what are the main type(s) of computers used, what the computers are used for, the 
benefi ts of computerisation in their assigned sector, any drawbacks of using computers in 
this sector. The summaries could be created using Word or PowerPoint. Graphics and tables 
should be used in the summaries.

(Note that other types of computers could be identifi ed in this task, such as smartphones, 
mainframes, and super computers.)

2. The learners should identify and use specifi c applications or software relevant to their 
research sector on their digital devices, if possible. Online videos could be used here such 
as the YouTube video shown below.

3. Each group should prepare a presentation to share their summaries with the class. Encourage 
creative presentation methods such as live demonstrations.

4. Each learner should then document their own experience of using a computer for this task 
noting how the device type(s) they used enhanced their engagement in the project.

5. Each group should compare desktop, laptop, tablet and server computers to each other using 
the table template on the previous page, or similar.
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Pedagogical Exemplars
Brainstorm: For example, a whole class brainstorming session on types of computers to introduce 
this week’s focal points. Note that this may highlight other types of computers such as mainframes 
and supercomputers.

Direct instruction and demonstration: The teacher goes through the main focal areas using a 
slideshow and demonstrates some popular online teaching tools (for example, Quizlet)

Blended Learning: The teacher should combine traditional classroom methods with online activities, 
allowing learners to pace their own learning and access resources beyond the classroom.

Project-Based Learning (in groups): Integrate digital devices in projects where learners can research, 
create presentations and collaborate with peers, fostering critical thinking and problem-solving skills.

Collaborative Learning: Facilitate group work using digital tools that enable communication and 
collaboration among learners, such as shared documents and discussion forums.

Digital Literacy Skills: Assist learners to effectively and responsibly use digital devices, including 
internet research, online safety, and the word processing and presentation software skills developed 
in weeks 2 to 6.

Key Assessments
Teachers should assess learners during the learning process. Marks can be assigned to presentations, 
contributions during work, research projects and more.

The summative assessment questions below are only to serve as a guide for the teacher when creating 
questions to measure learners’ comprehension of the two focal areas.

DOK Level 1: Recall and Reproduction

1.	 Complete the following sentence:
	 PC in the computing world stands for ___________________ __________________.
2.	 What is the name for a small electronic machine?

a.	 engine
b.	 car
c.	 gadget

3.	 Bobo, a salesman, uses a tablet to browse web pages while on the go. What input device 
does he use?

a. digital camera
b. touchscreen
c. printer

4. 	 A server computer would be classified as a PC?

a. true		
b. false

5. 	 State the name of the type of computer on a network that provides shared resources to the 
network users.

6. 	 State one major difference between a desktop computer and a laptop computer.
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7.	 Which of the following types of computers is not portable?

a. server
b. tablet
c. laptop

8. 	 Name the gadget shown in Figure 8.5. It can operate via spoken 
commands and is capable of streaming audio content, relaying 
information, and communicating with other devices.

9.	 List three smart gadgets commonly used today.
10. 	All PCs have a screen but only tablets will have a touchscreen.

a. true
b. false

11. 	Compare and contrast the functions of a server and a workstation in a computer network.
12. 	Paul retrieves a document from his company’s computer network and sends this document 

by email to a customer. The customer immediately responds to Paul’s email. Paul prints the 
customer’s reply for filing.

	 State the three types of servers that would be used in these transactions.
13. 	Identify two differences between a tablet and a desktop computer.

DOK Level 2: Skills and Concepts
14.	 Describe three differences between a desktop computer and a laptop computer under the 

headings: portability, form factor, processing power and peripheral devices. Use a table in 
Word to present these differences. Insert an image of each type of computer into your table.

15.	 Describe three typical tasks that a teacher would use a desktop for in his/her work.
16.	 Describe how the form factor of a desktop computer differs from that of a laptop computer and 

suggest ways that this could impact usability.
17.	 Create a PowerPoint multimedia presentation that summarise the main features of the following 

types of computers: desktop, laptop, tablet, and server. Devote one slide to each type of computer.
18.	 Kwame is about to start university. He plans to use his laptop to access his online lectures.

a. 	 What hardware component must the motherboard have for connecting the motherboard to 
the internet?

b. 	 Describe two other possible uses of his laptop by Kwame to help with his studies.

DOK Level 3: Strategic Thinking
19.	 Thema is an IT technician who regularly has to travel to different buildings to fix computers. 

She needs to log the repairs she makes while she is out of the office. What type of digital device 
should she use? Justify your choice of device.

20.	 You have to word process and print a report for History class. Identify what would be the most 
suitable type of computer to use. Justify your choice of computer and list the input, output and 
storage devices of your chosen type of computer that you would need for this task.

Figure 8.5
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21.	 Identify what type of household smart system is  
illustrated in Figure 8.6.

	 Explain how this smart system could save a 
household money.

22.	 Kweku is about to start university and needs a computer 
to help him with his studies, to keep in touch with home 
and for entertainment (he likes to listen to music and to 
play video games). He has a budget of GH₵<teacher 
inserts amount> for the purchase of the computer.

	 Decide which type of computer Kwame should by. Justify your decision.
	 Source a suitable computer available to buy online or in person in Ghana. Snip an advert of your 

selected computer which should include the cost.
	 (Snip tool: Windows logo key + Shift + S or Mac Cmd + Shift + 5 or iPad screenshot (press the 

top- right button in portrait orientation, and either one of the volume buttons) and crop.)
23.	 Research five of the types of servers shown in Figure 8.7 and write a short report on the functions 

of your chosen servers.

Figure 8.7

DOK Level 4: Extended Thinking
24.	 Design a full desktop computer system specification tailored to meet the needs of a graphics 

designer considering both performance and aesthetics. Your specification list should include a 
suitable list of peripheral devices.

27. 	a. Assess the environmental impact of computing, considering manufacturing, usage, 
and disposal.

b. 	 Suggest ways how someone could minimise their computer’s impact on the environment.

28.	 Computers have evolved considerably over the past 55 years. Predict how computers will 
change over the next 55 years.

29.	 Propose a sustainable business model for a company that produces environmentally friendly 
laptop computers without compromising performance.

Figure 8.6
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Week 9
Learning Indicator: 	Explore the purpose and uses of smartphones, digital cameras, wearable 
devices, game devices, e-book readers, portable and digital media players.

Theme/Focal Areas: 
1. 	 Explore the purpose and uses of smartphones, digital cameras, wearable devices 

and game devices.
2. 	 Explore the link between smartphones and the increased use of social media 

platforms.

Smartphones – see 4 in Figure 8.1
A smartphone is a mobile phone that, as well as providing connection to a cellular network, performs 
many of the functions of a computer, typically internet access and an operating system capable of 
running downloaded apps. A smartphone can be classified as a type of PC with a touchscreen interface, 
as well being a smart device.

A variety of options exist for typing on a smartphone. All of these phones will have the on-screen 
keyboard and can have predictive text enabled where you press one key and the software predicts 
the word you want. A separate keyboard could be purchased that links a smartphone via a wired or 
wireless connection. Another option is a virtual keyboard that projects an image of a keyboard on a 
flat surface. Some phones run apps that convert your spoken work to text.

Messaging services allow users to send/receive text, pictures, and video links to/from other mobile 
phones. An alternative to sending and receiving messages via a plan from your mobile service 
provider is to use a mobile messaging app. Many messaging apps, such as WhatsApp, provide group 
chat capabilities and can be downloaded to your mobile device at no cost.

Uses of a smartphone
These include:

•	 Making and receiving voice calls
•	 Sending and receiving messages and emails
•	 Video chat
•	 Registering contacts
•	 Taking photographs
•	 Calculator, torch, alarm, etc. functions
•	 Browsing the internet using a mobile browser
•	 Playing games
•	 Mobile payment for goods or services
•	 Barcode scanning
•	 Photography and video recording
•	 Taking and searching notes
•	 Showing map of user’s location by GPS (Global Positioning System)
•	 Providing a digital assistant (for example, Siri on iPhones). where you can ask questions to the 

phone and it speaks responses back to you.
•	 Connecting to external devices wirelessly, for example, wireless headphones via Bluetooth.

Most smartphones use three types of storage: internal RAM, a microSD card and cloud storage.
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Smartphones and Social Media
Another common use of smartphones is accessing and interacting with social media platforms, 
anywhere and at any time. Social media platforms are online communication tools that enable 
people to interact with each other by sharing and consuming information. Figure 9.1 shows the 
names and logos of some of these platforms. With one click, users of social media can send messages, 
photos, and videos to one another, making long-distance relationships much easier to maintain. They 
can also stay up to date with the latest trends and topics simply by scrolling their newsfeed.

Figure 9.1: Some social media platforms

The most popular ten social networks worldwide as of January 2024 (ranked by number of monthly 
active users) are shown in Figure 9.2.

Figure 9.2: Number of monthly active users (Jan 24)
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Facebook was the social media platform that was most often accessed through mobile devices in 
Ghana (also as of January 2024). This accounted for a share of roughly 28 percent. It was followed 
by YouTube and Twitter with around 27 percent and 17 percent, respectively.

Smartphones have revolutionised social media for a number of reasons:

•	 More people have access to social media than ever before because of the rapid increase 
in ownership of smartphones over the past 17 years. As of the end of 2024, the number of 
smartphone users worldwide is predicted to reach 7.1 billion.

•	 There are now a huge number of social media apps available, each with its own specific purpose. 
This has given users more control over how they use and access their social media, as they can 
tailor their settings to suit their specific needs and interests. Most social media apps now have 
push notifications, which give alerts to any account activity so users can conveniently stay in 
touch with contacts in real-time.

•	 Smartphones enable users to access social media anywhere and anytime. They can check their 
Facebook feed while waiting in a queue in a shop or read X updates on their commute to work. 
They can capture photos, record videos, and share their thoughts without having to wait until 
they can access a desktop or laptop. This has enabled many to become more immersed in their 
social media networks as they can stay connected in real time.

All in all, the rise of the smartphone has completely transformed the way people interact and engage 
with social media. With the forecast of continued smartphone sales and the growth of different apps 
dedicated to social media usage, the popularity of this smartphone use will continue to grow.

Digital Cameras
A digital camera works in a similar way as a traditional camera. However, it captures the image on an 
electronic chip rather than on film. The images are then usually stored in a removable memory card. 
Digital cameras are more convenient than film cameras, and since buying and developing film are not 
necessary, operating costs are lower. Also, captured digital images can be instantly checked on the 
monitor and, if necessary, retaken. Digital photographs are easy to retouch and manipulate through 
image-editing programs such as Photoshop. Almost all modern cameras have in-built Wi-Fi and/or 
Bluetooth, meaning you can connect them up to your smartphone/computer without cables or a media 
card reader, for quick sharing of your images online via email or social media. A digital camera is an 
example of a digital device.

Many people nowadays use their smartphone for taking photographs and video, as they are light to 
carry, can take good quality photographs and videos, and are convenient for quickly sharing images 
online. Digital cameras, however, give more flexibility when it comes to lenses and accessories. They 
often have sensors that are much larger than those found in smartphones and this often results in a 
higher resolution or better quality image.

Standalone digital cameras are often categorised into four groups: digital SLR (or DSLR), mirrorless, 
compact, bridge, and phone camera. Each type has advantages and disadvantages, and some types are 
more expensive than others. Only DSLRs and mirrorless models have interchangeable lenses. For any 
teachers and learners interested in the differences in these four types, see the summary in Figure 9.3 
(source: https://sharpshotsphotoclub.co.uk/best-cameras-for-kids-and-teens/)
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Figure 9.3: Types of Digital Cameras

Wearable Devices
A wearable device is a small, mobile computing device designed to be worn and often communicate 
with another digital device using Bluetooth. Three popular types of wearable devices are activity 
trackers, smartwatches, and smart glasses, all of which can be classifi ed as smart devices.

An activity tracker
This smart device focuses on health monitoring, tracking fi tness-related 
activities such as distance walked, heart rate, pulse, calories consumed and 
sleep patterns. Some fi tness trackers also offer additional features such as 
a built-in GPS. This wearable device typically syncs, usually wirelessly, 
with an app on your computer or smartphone. They come predominantly 
in the form of wristbands. Examples include Fitbit and Garmin models.

Smartwatch
This smart device will also offer via an app health monitoring similar to a 
fi tness tracker. But this is only one of its features. It will also tell 
the time and communicate wirelessly with a smartphone to enable 
you to make and answer phone calls, read and send messages, 
access the web, make mobile payments, play music, and work 
with other apps. The main smartwatch companies include Apple, 
Huawei, Samsung, and Garmin. The Apple Watch continues to be 
the global smartwatch market share leader. The next generation 
of smartwatches is likely to be even more powerful and feature-
rich than the current crop of devices, with faster processors, more 
memory, and improved sensors. These watches will also probably 
run a wider range of apps and offer better integration with smartphones. AI in future smartwatches 
may also add new features such as interaction with a human fi tness coach.

Figure 9.4: Fitbit Charge 6

Figure 9.5: Apple Watch Series 11
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Smart glasses
This smart device functions just like normal glasses, with 
the added ability to connect via Bluetooth or Wi-Fi to your 
smartphone or other devices. Smart glasses can stream audio, 
take photos and videos, and some even offer augmented 
reality features. The wearer can view information or take 
photos and videos projected to a miniature screen in their 
field of vision.

Users control the device through voice commands or by 
touching controls on its frame. Some smart glasses also 
include mobile apps, such as fitness trackers. Ray-Ban 
Metas, Rokid Max, and Bose Frames Tempo are three examples of smart glasses.

Virtual Reality (VR) and Augmented Reality (AR) headsets
Virtual Reality (VR) is a computer-generated 
environment with scenes and objects that appear to 
be real, making the user feel they are immersed in 
their surroundings. A VR headset is a head-mounted 
digital device that provides a virtual reality 
environment for the wearer. One area of use is 
entertainment. VR headsets, like the Oculus Rift or the 
PlayStation VR, instantly immerse gamers in other-
worldly experiences.

Virtual Reality (VR) is not just about gaming. It is 
being used for many different applications such as in 
medicine for treating post-traumatic stress or phobias where VR is used to help patients face their 
fears in a controlled and supportive environment. It is being used also with 3D modelling to train 
surgeons across many areas of medicine and remove the risk of practicing on real patients. VR can 
also be used in education. Examples include experiencing experiments or dissections that are difficult 
to perform in the classroom, going on virtual field trips for Geography or Biology, or visiting a 
museum or battle site for History.

Whereas with virtual reality, you are immersed in a 
completely virtual environment with no link to your real 
world, augmented reality (AR) is a technology that overlays 
digital features onto the real world. Using a camera and 
clever tracking technology, augmented reality shows you the 
real environment with computer-generated elements on top 
on your phone or on the screens of an AV headset (another 
example of a digital device).

Some retail companies are making shopping more interactive 
and more accessible with augmented reality. Using AR 
technology, shops are letting their customers ‘try before they buy’. For example, the IKEA Place 
app lets you place virtual furniture in your house. Using a mobile phone and its camera, you can see 
what your room will look like with a scaled 3D model of the piece of furniture augmented on top. 
AR headsets, as shown in the example in Figure 9.8, are designed to overlay digital information, such 
as 3D graphics, text, or video, onto the user’s view of the real world. Smart glasses are sometimes 
used in AR applications. Compared to VR/AR headsets, smart glasses are usually thinner, more 
portable, and more ergonomic. However, they are generally less capable of rendering complicated 
environments and have less processing capacity.

Figure 9.6 Smart glasses with 
projected map and walking directions.

Figure 9.7: Oculus Rift and PlayStation VR

Figure 9.8: AR is transforming the 
gaming industry
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The most important benefits of both virtual and augmented reality are immersive learning, realistic 
simulations for skill development, and increased engagement, making it a valuable tool for education, 
training, and experiential learning in various fields.

Uses of wearable devices
Along with those mentioned earlier, these include:

•	 Wearable devices provide more insights into sports and fitness performance. Amateur and 
professional athletes from all over the world maximise their training regimes thanks to the 
biometric data captured through wearable technology such as the user’s heart rate, speed etc. 
Wearable devices can be a key to unlock the potential of these athletes.

•	 Wearable devices are used in the field of health. Patients who wear these smart devices can 
measure information ranging from body temperature to blood pressure, which is then relayed to 
their medical team in real-time. If something is flagged as a concern, doctors have a quicker way 
to accurately diagnose and treat the patient. This makes the entire treatment process quicker and 
more convenient.

•	 Wearable devices transform the gaming experience. In the game app, Pokémon Go. your 
smartphone tracks your location, the camera films your surroundings, and the app overlays 
digital Pokémon on top for you to catch. So when you are in the game, it looks like Pokémon are 
appearing right in front of your feet. The current version of Pokémon Go does not require an AR 
headset to play. However, the creators of Pokémon Go, have been working on an augmented-
reality headset prototype called the Lightship Visual Positioning System. This wearable device 
aims to bring Pokémon Go characters to life by allowing game creators to paste characters and 
objects into your vision.

Game Devices
A game device or games console is a digital device whose main purpose is for playing virtual, or 
‘video’ games on a screen. They are designed for single-player or multiplayer games. Some connect 
to a television or a monitor (such as Xbox and PlayStation). Others (such as Nintendo Switch and 
Super Pocket) are handheld with the screens built into them. Game consoles today, like an Xbox, 
Nintendo Wii, or Sony PlayStation, are like purpose-built computers. They contain a processor, RAM, 
and a hard drive, and they operate using an operating system, just like a computer.

Many consoles allow you to listen to music and to watch movies or view photos. Optical disk drives 
in the game consoles provide access to games and movies on CD/DVD. Game consoles that are 
internet capable enable gamers to download games, stream games, movies and audio, and play with 
others online. Some gamers connect keyboards or webcams so that they can more easily send text 
messages or conduct video chats with other gamers.

As players interact with a video game on the game console, they direct movements and actions 
of on-screen objects via a controller, voice, or air gestures. Game controllers include gamepads, 
joysticks and wheels, dance pads, and a variety of motion-sensing controllers. These controllers will 
communicate via a wired or wireless connection.
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Figure 9.9: Xbox Series X and PlayStation 5, two popular games consoles

Uses of a popular games console (PS5)
•	 Stream or download and play games from The PlayStation Store
•	 Stream Movies and TV Shows: The PS5 has a long list of popular streaming services you can 

download from, including Netflix and Amazon Prime Video
•	 Play DVDs and Blu-ray Disks: The PS5 can read DVDs and high-quality Blu-ray disks. Note 

that PS5 does not support CDs. You could, however, transfer the files from CDs to a USB stick 
and use that instead.

•	 Listen to Music: You can play music on your PS5 through online streaming services.
•	 Browse the internet: The PS5 has an internet browser which you can use by changing to a few 

settings. However this browser is rather limited; for example, it will not let you load multimedia.

As you can see, the PS5 is more than just a games console. The only thing stopping it from being a 
full-blown computer is its limited operating system. These statements are also true for some other 
games consoles.

Learning Tasks

Teachers should assess learners during the learning process. Marks can be assigned to 
presentations, contributions during work, research projects and more.

The summative assessment questions below are only to serve as a guide for the teacher when 
creating questions to measure learners’ comprehension of the two focal areas.

Group Activities

Task 1

1.	 Where there are available resources (digital devices such as PCs and internet access), divide 
learners into small groups (with consideration of GESI, SEL and other pertinent issues). 
Each group should be given one of the following to discuss and research: smartphones, 
digital cameras, and wearable devices. The teacher may wish to provide some headings to 
direct the research such as main purpose, uses, typical users, design, portability, and cost.

2.	 Each group should summarise their research finding using Word, PowerPoint or other 
suitable computer application. Graphics and tables should be used in the summaries.

3.	 Each group should prepare a presentation to share their summaries with the class. Relevant 
short online videos should be reviewed with a couple included in the presentation from each 
group.
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4. Encourage live demonstration of associated devices, if possible. For example, a learner 
could demonstrate how to transfer images taken from a smartphone to a school computer.

Task 2

Repeat Task 1 but change the research focus to games devices. Assign each group a different 
games device, remembering to include some portable, handheld devices. The groups should 
include an advert for a recent model of their assigned device. Learners’ assessments of their own 
experiences of using these devices should be encourage d.

Pedagogical Exemplars
These examples are only to serve as a guide to the teacher.

Direct instruction and demonstration: The teacher goes through the main focal areas using a 
slideshow and, where possible, demonstrate the digital devices being studied.

Video-assisted learning (VAL): There are a large number of suitable online videos that could be 
incorporated into these lessons that would increase learner comprehension of the focal areas and 
lesson engagement. An example is a YouTube video on a demonstration of an AR headset:

HoloLens 2 AR Headset: On Stage Live Demonstration

Think-Pair-Share: The teacher poses a number of questions relating to the focal areas. An example 
of a question is ‘Why would someone choose to purchase a smartwatch rather than a fi tness tracker 
device if they wish to track their fi tness?’ Learners think individually about the answers before 
sharing with a learner beside them (pair). Each pair group then shares their chosen response with the 
whole class.

Blended Learning: The teacher should combine traditional classroom methods (such as pupil 
worksheets) with online activities, allowing learners to pace their own learning and access resources 
beyond the classroom.

Project-Based Learning: Integrate the focal areas into projects where learners can research, create 
presentations, and collaborate with peers, fostering critical thinking and problem-solving skills. 
Examples of projects are included in the Learning Tasks and Key Assessments.

Group Discussions: Facilitate group discussions where learners can share their experiences and 
insights about using the digital devices studied this week.

Inquiry-based learning: Learners are given a real-world problem to solve and they are asked to 
apply what they have learned this problem. For example, what digital devices can be used by a 
football coach in his/her work and how could they be used?
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Collaborative Learning: Facilitate group work using digital tools that enable communication and 
collaboration among learners, such as shared documents and discussion forums.

Digital Literacy Skills: Assist learners to effectively and responsibly use digital devices, including 
internet research, digital citizenship, and online safety. Time should be devoted to inform learners of 
both the risks and opportunities presented by interacting with online social media platform s.

Key Assessments
Teachers should assess learners during the learning process. Marks can be assigned to presentations, 
contributions during work, research projects and more.

The summative assessment questions below are only to serve as a guide for the teacher when creating 
questions to measure learners’ comprehension of the two focal areas.

DOK Level 1 (Recall and Reproduction)
1. Identify the primary input device of a smartphone.
2. VR stands for v_____________ r_____________ .
3. A smartphone can make and receive voice calls. List three other uses of smartphones in daily life.
4. Instant image review and feedback is an advantage of which digital device?
5. Name a games console made by Microsoft.
6. What is the main purpose of a camera phone?
7. What are a pair of glasses that contain computer technology commonly called?
8. Complete the sentence: A smartphone is a mobile phone that performs many of the functions of 

a _______________ .
9. State the name of the software that enables a smartphone to run apps.
10. When a mobile phone is in airplane mode, you will still be able to make calls.

a. true
b. false

11. List three types of media that will be processed by a games console when a game is being played.
12. What is the purpose of smartphone status icon circled on Figure 9.10?

Figure 9.10

DOK Level 2 (Skills and Concepts)
13. Describe two advantages and one disadvantage of using a smartphone for taking photos over 

using a dedicated digital camera.
14. Demonstrate how to do the following on a smartphone:

• browse the internet
• send a text message
• take a photo
• navigate to an app store
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15.	 Describe two possible uses of a games console other than playing video games.
16.	 Outline the set of steps required to connect wireless headphones to a smartphone.
17.	 How does a traditional camera differ from a digital camera?
18.	 Compare the features of three smartphone models that cost no more than <enter amount here>. 

Snip an online advert for each phone and paste in a Word report. Use a table to compare the 
main specifications of the three phones.

19.	 What is the biggest benefit of owning a smartphone over a standard mobile phone? Give 
reason(s) for your answer.

20.	 Explain the main difference between virtual reality and augmented reality.
21.	 Explain how smartwatches utilise sensors to track fitness activities and monitor health metrics.
22.	 Describe the impact of smartphones on social media.
23.	 Describe the difference in gameplay experience between the PS1 console and the PS5 model.
24.	 A smartphone can serve as a wireless access point to connect to a network. Outline the steps to 

set this up.
25.	 Create a slideshow that lists at least four possible uses of each of the following digital devices:

•	 Smart glasses
•	 AV headset
•	 PlayStation 5
•	 A smartwatch
•	 A smartphone
Insert links into your slideshow to online videos showing these devices in operation.

DOK Level 3 (Strategic Thinking)
26.	 Evaluate the role of smartphones in facilitating information access and providing entertainment.
27.	 Develop a plan for organising and managing apps, files, and settings on a smartphone to optimise 

its performance.
28.	 A visitor to Accra needs assistance to find her way from the lorry station to her hotel. Suggest two 

possible smart devices that can assist her. Describe how they can be used for this navigation task.
29.	 Describe two differences between a fitness tracker and a smartwatch.
30.	 Evaluate the use of the following devices in the training of pilots:

•	 VR headset
•	 Smart glasses
•	 AR headsets

	 Choose which device do you think would be most effective for this application. Justify 
your choice.

31.	 Evaluate the ethical considerations of using drones for aerial 
photography and surveillance.

32.	 What do VR headsets and AR headsets have in common?
33.	 How do smartphones and social media impact communication?
34.	 The Smart Glove (Figure 9.11) is a dual-purpose training accessory 

to help ensure better wrist and grip position in the game of golf. One 
of the keys to great ball striking is a firm left wrist at swing impact Figure 9.11
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and a proper golf grip. The Smart Glove, with removable wrist guide, sets your wrist in the 
correct position through the swing with a proper wrist release.

	 Research this product online, carefully reading customer reviews. Use this information to 
provide your own assessment of the Smart Glove. Do you think that it would help someone be 
a better golfer?

DOK Level 4 (Extended Thinking)
35.	 Predict how the further development of augmented reality will impact online gaming.
36.	 ‘Artificial intelligence is powering the AR future’. Develop an argument to support this 

statement.
37.	 Outline any issues that you think might arise from personal smartphone use in the workplace.
38.	 Research the area of smart jewellery. Use the computer to summarise your findings which 

should include images of some examples of smart jewellery.
39.	 Investigate how artificial intelligence may revolutionise the functionality of smartphones. Write 

a short report summarising the findings of your investigation.
40.	 Use the internet to explore what is meant by ‘fashion tech’. Design your own piece of fashion 

tech, and create a poster using paper and pens, or the computer, to illustrate your design.
41.	 The first social media site was born (SixDegrees.com) in 1997. Create a timeline for social 

media platforms from 1997 to 2024.



98

SECTION 2: DIGITAL DEVICES- EXAMPLES AND IMPORTANCE

Week 10
Learning Indicator: Explore the purpose and uses of smartphones, digital cameras, wearable 
devices, game devices, e-book readers and portable digital media players.

Theme/Focal Areas:
1. 	 E-book readers
2. 	 Media players
3. 	 What makes a digital device smart?
4. 	 The different types of wireless connections
5. 	 The benefits of smart devices
6. 	 The Internet of Things

E-Book Readers
E-book readers, also known as e-readers, are handheld portable smart devices that use software to 
display books, periodicals (magazines, newspapers), and other text-based content on a screen. The 
primary purpose of an e-book reader is for the reading of digital e-books and periodicals. Note that 
PCs (desktops, laptops, tablets and smartphones) can also be used to read e-books by installing an 
e-book reader app such as the Kindle app.

The Amazon Kindle e-book readers continue to dominate the e-book reader market, but companies 
such as Kobo, Nook, and Onyx also manufacture these devices.

Reading material can be downloaded to these devices from online stores such as Amazon, Apple, 
Barnes & Noble and eBooks.com via a wireless or 4/5G connection. You can also download books to 
a PC or Mac and then transfer them to your e-reader via a USB cable.

•	 Touchscreen
•	 USB-C Charging port
•	 Adjustable screen light
•	 Dark Mode
•	 VoiceView screen reader 

over Bluetooth
•	 16GB internal storage, with 

approx. 13GB available to the user
•	 Size: 6.9” x 4.9” x .32” (174.2 x 

124.6 x 8.1 mm)
•	 Released 2022

Figure 10.1: Kindle Paperweight (11th edition)

One of the advantages of an e-reader is the ability to download free samples to see if a book is to your 
liking before committing to pay. There are also a large number of free ‘out of copyright’ classic books 
available to fill your library at no cost. You can use the dictionary feature to look up the meaning 
of a word while reading. Many e-readers will offer the names and synopsis of books based on our 
previous book choices.
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A popular model of e-reader is the Kindle Paperweight - see Figure 10.1. At 30 mins of reading 
per day, the battery is advertised to last for over a month. For a more active reader, it will last 2–3 
weeks at least.

Key	features	and	benefi	ts	of	an	e-book	reader
• Most models store at least 1,000 books.
• Screens allow you to read even in bright sunlight without glare.
• Some models include a built-in light for night-reading.
• Clear text and fonts, and a sharp display. Some allow you to customise fonts.
• Adjustable text size.
• Built-in Wi-fi  and, in some cases, 4/5G connection.
• Long battery life.
• Page-turning function so you feel as if you are reading a real book.
• They do not heat up like a laptop.
• Books can be categorised or stored as collections.
• Readers can make notes and highlight pieces of text.
• Your own documents can be saved to your device.
• Screen can be rotated for better viewing of pictures, diagrams, maps, etc.
• Also able to read newspapers, magazines and web pages.
• In-built or on-screen keyboard enables searching within a book, a library or online.
• You can add your own annotations to the text.
• Dictionary feature.
• Automatic bookmark.

Portable Media Players
Digital media includes images, video and audio. A media player is a software or a hardware device 
that is used to play digital media fi les. It can play these fi les from a storage device or streamed from 
the internet. Examples of media player software include Windows Media Player, VlC media player, 
and iTunes.

A smart TV and a games console are devices that can play audio or video material, and display photos 
but these notes will focus on the smart devices that are labelled ‘digital media players’, also known 
as streaming boxes and streaming sticks.

The purpose of these devices is to stream video and music content on your TV via an internet 
connection. Roku, Amazon, and Apple are three companies that produce both streaming boxes and 
streaming sticks – see Figure 10.2 and Figure 10.3.

Both have RAM and a processor with operating system that 
can run apps to access on-demand services like Netfl ix, Hulu, 
Disney+, Spotify as well as live TV streaming through a user 
interface. The box or stick connects to your TV’s HDMI port 
for video output while connecting to a home Wi-Fi network to 
access the internet. A remote control is used for access.

Figure 10.2: Roku box and 
Apple TV box

Figure 10.3: Roku stick

Figure 10.4
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Some will include voice controls through a digital assistant (e.g. Amazon Alexa with the Amazon 
Fire TV stick), as well as parental controls.

Both box and stick are small, light and portable, which means that they can be used to access a 
person’s streaming content on any TV with an HDMI port. Because of size, a streaming stick is a 
little more portable. Streaming boxes tend to be more powerful with additional features but are more 
expensive.

What Makes a Digital Device Smart?
We use smart devices every day, but what exactly makes a digital device smart? A formal definition 
of a smart device is:

A smart device is a wired or wireless context-aware digital device capable of performing autonomous 
computing and connecting to other devices for data exchange.

Context-aware is the ability to gather information about its environment at any given time and adapt 
behaviours accordingly. For example, cameras, microphones and GPS receivers can provide essential 
data to an AR headset that will determine the view on the visor/screen.

Performing tasks autonomously means acting without the direct command of the user. For example, 
our smartphones making suggestions based on the current weather.

Connectivity refers to the ability of a smart device to connect to a data network. Network connectivity, 
whether wired or wireless, is a crucial feature that enables a device to be a part of the Internet of 
Things (IoT) which is explored later.

Wireless Device Connections
Instead of connecting computers and mobile devices to peripheral devices through 
ports and connectors, some peripheral devices use wireless communications 
technologies such as Bluetooth, Wireless Fidelity (Wi-Fi) and Near Field 
Communication (NFC). Many of the digital devices studied in Week 9 supported 
a wireless connection(s).

Bluetooth
Bluetooth technology uses short-range radio signals to transmit data between two Bluetooth-enabled 
computers or devices. In addition to computers, mobile devices and many peripheral devices, such 
as a mouse, keyboard, printer, or headset, and many vehicles and consumer electronics are Bluetooth 
enabled. The range of a Bluetooth connection is approximately 10 metres. However, maximum 
communication range will vary depending on obstacles (person, metal, wall, etc.) or electromagnetic 
environment. The range may be able to be extended with additional equipment. If you have a computer 
that is not Bluetooth enabled, you can purchase a Bluetooth wireless port adapter that will convert an 
existing USB port into a Bluetooth port.

Wi-Fi
Wi-Fi (Wireless fidelity) uses radio signals that conform to 802.11 standards. Computers and 
devices that have the appropriate Wi-Fi capability can communicate via radio waves with other Wi-
Fi computers or devices. Most computers and mobile are Wi-Fi enabled, along with routers and 
other communications devices. The reach of your signal will be impacted by the manufacturer of the 
equipment that you are using, the location where your router is installed, and the obstructions that 
might block the signal in your home or business. Routers set to a 2.4Ghz frequency that are correctly 
placed should offer you coverage for about 45 metres indoors and about 90 metres outdoors.

Figure 10.4
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NFC
NFC uses close-range radio signals to transmit data between two NFC-enabled devices. Examples 
of NFC-enabled devices include many smartwatches, most smartphones, and some digital cameras, 
computers, and smart televisions. Other objects, such as contactless debit and credit cards, and 
contactless travelcards, also use NFC technology. For successful communications, the devices either 
touch or are within a distance of 4 centimetres of each other.

Scan these QR codes for more information as described.

Pairing Bluetooth Devices Uses of NFC devices Phone to a Wi-Fi Network

Advantages of Smart Devices
The term ‘SMART’ in smart technology originally comes from the acronym Self-Monitoring, Analysis 
and Reporting Technology. It has evolved to broadly refer to technology that can interact with users, 
learn from interactions, and make decisions based on data it collects.

Smart devices have become an integral part of life for many people, offering a multitude of benefi ts 
that enhance their daily routines. These benefi ts include:

1. Enhanced Convenience and Effi ciency: Smart devices, ranging from smartphones to smart 
home appliances, are designed to make our lives more convenient and effi cient. They provide 
quick access to information, enabling you to streamline tasks such as setting alarms, creating to-
do lists, and managing your schedule with ease. With voice-activated virtual assistants like Siri 
or Alexa, you can control these devices and access information using just your voice, saving 
you time and effort.

2.  Improved Connectivity: The world has become more connected than ever, thanks to smart 
devices. They enable us to stay in touch with friends and family no matter where they are in 
the world. Whether through social media, video calls, or messaging apps, smart devices have 
made communication seamless. Smart home devices can be controlled and monitored remotely, 
ensuring peace of mind even when the owner is away from home.

3. Enhanced Health and Fitness Tracking: Smart wearables, such as fi tness trackers and 
smartwatches, have revolutionised the way many people monitor their health and fi tness. These 
gadgets can track their steps, heart rate, and sleep patterns, and even provide insights into your 
overall health. By collecting and analysing this data, a person can make informed decisions to 
improve his/her well-being.

4. Energy Effi ciency: In an era where environmental consciousness is crucial, smart devices 
contribute to energy conservation. Smart thermostats, for example, can learn temperature 
preferences and adjust settings to save energy. This not only reduces the carbon footprint of 
homes but also results in cost savings on utility bills.

5. Entertainment On-Demand: Smart devices have brought entertainment to our fi ngertips. With 
streaming services like Netfl ix, Hulu, and Disney+, you can enjoy movies and TV shows on 
your terms. Smart TVs and speakers also allow you to control your entertainment through voice 
commands, making your downtime even more enjoyable.
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6.	 Enhanced Home Security: Home security has evolved significantly with the introduction of smart 
gadgets. Smart doorbells, surveillance cameras, and alarm systems offer remote monitoring and 
real-time alerts, giving peace of mind to the owner whether at home or away. He/she can keep 
a close eye on property and loved ones, enhancing safety and security.

7.	 Increased Productivity: Smart devices are indispensable tools for professionals. They provide 
the flexibility to work remotely and stay organised. Tablets and smartphones come with a suite 
of applications for document editing, email management, and virtual meetings, allowing you to 
remain productive on the go.

8.	 Customisation and Personalisation: Many smart gadgets are designed to adapt to a person’s 
preferences and needs. They can learn their routines and adjust settings accordingly. This level 
of customisation ensures that a person’s devices work in harmony with their lifestyle.

9.	 Educational Opportunities: Smart gadgets are powerful tools for learning and education. With 
access to online courses, e-books, and educational apps, you can expand your knowledge in 
various subjects and skills and have the convenience of learning at your own pace.

The Internet of Things
The Internet of Things (IoT) connects digital devices over the internet and enables them to collect 
and exchange data. The connected devices can be activated using voice commands or be controlled 
by downloading and using an app or via a Bluetooth or Wi-Fi connection. The main steps involved 
in the working of the IoT are:

1.	 The connected devices have embedded sensors that collect data.
2.	 The data collected by the sensors is then shared via the cloud and integrated with software.
3.	 The software then analyses and transmits the data to users via an app or website.

A smart refrigerator is an example of an IoT appliance. It can monitor food inventory, suggest recipes 
and send alerts about expiring items. A smart home security camera is another IoT example, providing 
remote monitoring of a home and its grounds, and generating alerts via smartphones.

Another example relates to an agriculture application. Automatically getting information about soil 
moisture can tell farmers exactly when crops need to be watered. Instead of watering too much or 
too little (either of which can lead to bad outcomes), the farmer can ensure that crops get exactly the 
right amount of water. Sensors can be used to collect information about soil moisture and the farmer 
can use this information to activate the irrigation system, or turn it off as appropriate. With an IoT-
enabled system, the farmer is not needed. The irrigation system can automatically act when required, 
based on how much moisture is detected.

An extension: If the irrigation system receives information about the weather from its internet 
connection, it can also know when it is going to rain and decide not to water the crops as they will 
soon be watered by the rain.

A further extension: All this information about the soil moisture, how much the irrigation system is 
watering the crops, and how well the crops actually grow can be collected and sent to supercomputers 
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in the cloud that run algorithms that analyse all this information, leading to models that could be used 
to predict future growing conditions and prevent losses.

Figure 10.5

Notice a vehicle is included in the diagram in Figure 10.5. IoT devices can help fleet operators 
monitor and manage the fleets of IoT-enabled vehicles, tracking fuel consumption, optimising routes, 
and scheduling maintenance, to improve efficiency and reduce costs. Additionally, IoT in vehicles 
can share statistics on driver performance and health, such as detecting tiredness, and sending alerts.

It is estimated that there are approximately 17.08 billion connected IoT devices globally (April 2024). 
By 2025, it is estimated that there will be more than 21 billion IoT devices. New and emerging 
technologies such as AI, edge computing, 5G connectivity, and blockchain security will guarantee 
their continued rapid expansion beyond 2025.

Learning Tasks

Teachers should assess learners during the learning process. Marks can be assigned to 
presentations, contributions during work, research projects and more.
The summative assessment questions below are only to serve as a guide for the teacher when 
creating questions to measure learners’ comprehension of the six focal areas.

Group Activities

Task 1 – Research and share
After the learners have an understanding of the main points about e-book readers and portable 
media players, they should work in small groups using the internet to find out more about these 
two types of digital devices. Each group should then share their findings with the whole class.

Task 2 – Research and share
Working in small groups, learners should be given different scenarios where two digital devices 
could be used. For example, reading an e-book with a tablet or an e-book reader. The relative 
pros and cons of each device for the given application should be discussed with the group and 
documented, before being shared with the whole class.
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Task 3 – Matching activity
(a)  The teacher should print out images or associated images of various digital devices along 

with separate cards containing descriptions of a functions or uses of these devices. Learners 
working together should match each digital device picture with the correct description card.

(b) Learners should then discuss within their group why each digital device is suited for the 
given use(s) and suggest possible alternative devices. The outcomes of the group discussions 
should be shared with whole class.

Task 4 (Task 2 from a different perspective)
Ask learners to think of scenarios where alternative devices could be employed. They should 
select which device would be best and explain their reasoning.
Task 5 – Mind maps
Individually or in small groups, create a mind map for each of the following:
• Applications of the Internet of Things

• The effi ciency and convenience of smart devices in the home.

Task 6 – Concept map
Individually or in small groups, create a concept map for the digital devices covered in this 
section of the SHS 1 ICT course. 

Pedagogical Exemplars
These examples are only to serve as a guide to the teacher.

Group Discussions: Facilitate group discussions where learners can share their experiences and 
insights about using any of the digital devices examined this week.

Direct instruction and demonstration: The teacher goes through the main focal areas using a 
slideshow and, where possible, demonstrate the digital devices being studied. For example, how to 
bookmark a page if an e-book reader is available.

Video-assisted learning (VAL): There are a large number of suitable online videos that could be 
incorporated into these lessons. They would increase learner comprehension of the focal areas and 
their engagement in lessons. An example is a YouTube video on the IoT:
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Think-Pair-Share: The teacher poses a number of questions relating to the focal areas. An example 
of a question is ‘What concern should you have of using your phone for contactless payment of 
goods?’ Learners think individually about the answers before sharing with a learner beside them 
(pair). Each pair group then shares their chosen response with the whole class.
Blended Learning: The teacher should combine traditional classroom methods (such as pupil 
worksheets) with online activities, allowing learners to pace their own learning and access resources 
beyond the classroom.

Project-Based Learning: Integrate the focal areas into projects where learners can research, create 
presentations, and collaborate with peers, fostering critical thinking and problem-solving skills. 
Examples of projects are included in the Learning Tasks and Key Assessments.

Inquiry-based learning: Learners are given a real-world problem to solve and they are asked to 
apply what they have learned to solve this problem. Suggest how smart devices could help to mitigate 
natural disasters (e.g., floods, earthquakes) and thus save lives.

Collaborative Learning: Facilitate group work using digital tools that enable communication and 
collaboration among learners, such as shared documents and discussion forums.

Digital Literacy Skills: Assist learners to effectively and responsibly use digital devices, including 
internet research, digital citizenship, and online safety. Time should be devoted to discuss the data 
privacy issues concerning the use of smart devices.

Group Discussions: Facilitate group discussions where learners can share their experiences and 
insights about using different digital devices.

Research Projects: Assign research projects where learners investigate the evolution of digital 
devices and their impact on society.

Case Studies: Present real-world scenarios where different digital devices are used. Discuss why 
certain devices are preferred over others in specific situations.

Hands-On Experience: Where possible, provide learners with the opportunity to use the digital 
devices studied this week. These experiences can help solidify their understanding of these devices.

Key Assessments
Teachers should assess learners during the learning process. Marks can be assigned to presentations, 
contributions during work, research projects and more.

The summative assessment questions below are only to serve as a guide for the teacher when creating 
questions to measure learners’ comprehension of the six focal areas.

DOK Level 1: Recall and Reproduction
1.	 IoT stands for I_____________ of ________________ .
2.	 State the main purpose of an e-book reader.
3.	 What technology enables contactless payments?
4.	 Complete the following sentence:
	 S__________ d_____________ contain sensors, processors, and software that enable data 

collection, data analysis, and decisions based on this analysis.



106

SECTION 2: DIGITAL DEVICES- EXAMPLES AND IMPORTANCE

5.	 Can you read an e-book without the internet?

a. yes
b. no

6.	 What type of media is streamed from the following platforms?

a. Spotify
b. Netflix.

7. 	 What is the main function of a digital media player?
6. 	 Smart home devices cannot be hacked or used to spy on you.

a. yes
b. no

9.	 When digital gadgets are connected together using the internet is better known as what?
10. 	Which of these is a wireless technology:

a. NFC
b. Ethernet
c. Fibre optics

11. 	A streaming stick can be connected to a smart TV?

a. yes
b. no

12. 	Which of the following would allow you to stream a movie?

a. Apple TV
b. Kindle Paperweight
c. Samsung Smart TV

DOK Level 2: Skills and Concepts
1.	 Explain when and why an e-book reader needs to be connected to the internet.
2.	 What is the main advantage of a digital media player being portable?
3.	 Give three advantages of an e-book over a printed book.
4.	 Smart devices are intended to automate tasks and provide real-time data and feedback to users, 

making their lives easier and more convenient. Explain how this automation is achieved.
5.	 Describe two advantages and one disadvantage of wireless connections over wired connections.
6.	 a. 	 Describe two advantages of using an e-book reader for reading e-books compared to 

using a tablet.

b. 	 Describe two advantages of using a tablet for reading e-books compared to using an 
e-book reader.

DOK Level 3: Strategic Thinking
19.	 Assess the security risks associated with smart devices.
20.	 A phablet is an example of a smart device. Create a short report describing what is meant by a 

phablet and comparing it to a tablet.
21.	 Smart devices bring many benefits but describe the concerns about smart devices.
22.	 Evaluate whether it is better to get a streaming box rather than a smart tv.
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23.	 ‘E-book readers are a powerful resource in schools’. Give pros and cons of this opinion.
24.	 Analyse the impact of smart home devices on energy efficiency and home security.
25.	 Create a presentation on how the Internet of Things is changing lives. Focus on the impact of 

IoT applications in at least two areas from:

•	 Smart homes/buildings
•	 Healthcare
•	 Transportation
•	 Agriculture
•	 Retail

26.	 Create a concept map for your understanding of smart devices.

DOK Level 4: Extended Thinking
27.	 Predict the future trends in smart technology and how they might revolutionise lifestyles in the 

next decade.
28.	 Design a new smart gadget. Create a diagram/illustration(s) of your design with annotations 

describing what your gadget would be used for.
29.	 Design a concept for an advanced AI assistant that can enhance productivity in a school office.
30.	 Research what is meant by blockchain technology and how it could revolutionise data security 

and privacy in future smart devices.
31.	 Develop a strategy for securing IoT devices from potential cybersecurity threats in a smart 

home environment.

Section Review
This section has focused on developing the learners’ understanding of the use of ICT in society 
with an emphasis on the purpose and uses of a range of digital devices, and an examination of 
some emerging technologies such as smart technology and the Internet of Things. By the end of 
this section, learners should be able to describe the main features and the purpose and uses of 
the following digital devices: smartphones, digital cameras, wearable devices, game devices, 
e-book readers, and portable digital media players. Learners were also expected to explore the 
differences between desktop, laptop, tablet, and server computers. The teacher will have guided 
the learners in examining how the growth of smartphones has transformed the way people 
interact and engage with social media. This would also have given an opening to teachers to 
discuss the uses, benefits and pitfalls of social media platforms.

Through a study of the topics in this section, learners should hopefully have developed an 
appreciation and a deeper understanding of many current and some emerging IT technologies. 
This should lay a sound foundation for the remainder of the SHS 1 ICT course. The suggested 
activities in the manual have a strong focus on critical thinking, problem-solving, and teamwork 
which are three important life skills.

Additional Reading
1.	 O’ Leary, T. J., & O’ Leary L. I. (2017). Computing Essentials, 26th edition. New York: 

Mcgraw Hill.
2.	 Wempen, F. (2014). Computing Fundamentals: Introduction to Computers. New York: Wiley.
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3.	 Rajaraman, V. (2018). Introduction to Information Technology. PHI Learning Pvt. Ltd.
4.	 Vermaat, M., E., Sebok, S., L., & Freund, S., M. (2014). Discovering Computers: 

Technology in a World of Computers, Mobile Devices, and the Internet, Course Technology, 
Cengage Learning
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SECTION 3: INTERNET EVOLUTION, ISPS AND THEIR 
FUNCTIONS

Strand: ICTs in the Society

Sub-Strand: Connecting and Communicating Online

Content Standard: Demonstrate knowledge and understanding on the use of the Internet

Learning Outcome: Discuss and use internet applications

INTRODUCTION
The focal areas of Weeks 11 and 12 will be the study of the internet which includes the exploration 
its main services, its advantages and disadvantages, and a brief overview of how it works, as well as 
the role of internet service providers (ISPs). This study will overlap with one of the focal areas of this 
section: how the internet has evolved.

There will be many opportunities for the teacher and peers to guide learners in extending their digital 
literacy skills in these two weeks. For example, the study of the key concepts and the process of 
completing a range of practical tasks that involve the use of the internet will hone the abilities of the 
learners to search and navigate the world wide web in a responsible and efficient manner. This is a 
valuable digital literacy skill that is transferable across different subject areas.

An outline of the work covered in this two-week section
	 Week 11:A study of the internet – what is it, its services, advantages and disadvantages, a brief 

overview of how it works, and its evolution
	 Week 12: Internet service providers – what are they, their functions/services, and a brief outline 

of how they work.

SUMMARY OF PEDAGOGY
This section considers a variety of teaching and learning approaches, strategies and techniques. 
These include hands-on activities where learners engage in practical activities to research, explain 
and demonstrate. Where appropriate learners should be offered the opportunity to work in groups 
to find solutions to assigned tasks. Teachers are advised to ascertain what levels of engagement and 
competence pupils have with various online tools to help with the formation of groups.

Experiential learning activities with mixed-ability/mixed gender groupings should dominate the 
lessons in this section. All learners, irrespective of their learning abilities should be encouraged to 
participate fully in lessons. And, of course, make considerations and accommodations for the different 
learning styles. Offer below average/approaching proficiency learners the opportunity to make oral 
presentations when it is deemed fit, and provide more challenging extension activities for the above 
average/highly proficient learners Practical sessions and project-based learning will increase learner 
engagement, foster valuable collaboration and teamwork skills, and provide opportunities to practise 
their word processing and presentation skills introduced in Weeks 2 to 6. There should be a greater 
emphasis on the process of using the internet as a research tool in these lessons – paying attention that 
the correct internet terminology is used and showing the learners the best techniques to use search 
terms and identify credible sources when using the WWW.
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Brainstorm, brain write and discuss will have a place, in particular when introducing topics or during 
plenary sessions. Allow the learners to engage in related hand-on activities whenever possible; 
for example, doing a Ping test to check the school’s internet speeds. Carefully selected videos and 
animations in lessons will make some of the content more accessible.

SUMMARY OF ASSESSMENT
The assessment (formative and summative) section takes into consideration all four levels in the Revised 
Bloom’s Taxonomy. Level 1(Recall/Reproduction), Level 2 (Skills/Conceptual understanding), Level 
3 (Strategic Thinking/ Reasoning), and Level 4 (Extended Critical Thinking and Reasoning). There 
are assessment suggestions that can fit to different levels of ability - learners approaching proficiency 
(AP), proficient (P) learners and highly proficient (HP) learners. Apart from the traditional form of 
practical and written tests and assignments, assessment in this section can include many other forms. 
These include demonstrations of how to do a practical task relating to a focal area (for example, how 
to connect a smartphone to a Wi-Fi network), mind maps and concept maps, multiple choice quizzes, 
group projects, self-assessments, oral presentations, peer review, portfolios, debates, game-based 
assessments, digital storytelling, and matching tasks.

Please note that the key assessment items in this manual are only to serve as a guide for the teacher 
to establish learners’ understanding of the course material. They do not in any way limit the teacher 
from exploring and creating his/her own questions.
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Week 11
Learning Indicator: Describe the evolution of the Internet and identify the Internet Service 
Providers (ISPs) and their functions.

Theme/Focal Areas:

1.  What is the internet?
2.  Internet services
3.  The evolution of the internet
4.  Advantages and disadvantages of the internet
5.  A simple overview of how the internet w orks

What is The Internet?
The internet is a global system of interconnected private, public, academic, business and government 
computer networks that facilitate communication and data services using a suite of communication 
protocols called the Transmission Control Protocol/Internet Protocol (TCP/IP). It is a network of 
networks linked by a broad array of electronic, wireless and optical networking technologies.

Internet Services
The internet provides a vast range of services, including:

The World Wide Web (WWW), often referred to as the internet’s backbone, refers to all the public 
websites that users can access on their computers through the internet. Web pages and documents on 
these sites are interconnected by means of hyperlinks that users click on for information. Users access 
and navigate websites through programs called web browsers.

Figure 11.1: Some popular internet browsers

Email, short for electronic mail, is a convenient, fast, and economic means of exchanging messages. 
These messages can include text, pictures and animations, and can have fi le attachments. Email has 
become an essential tool for personal and professional communication.

Examples of web based email providers are Gmail, 
Outlook, and AOl.

Social networking uses internet-based social media 
platforms to connect with friends, family, or peers. 
Marketers use social networking to increase brand 
recognition and encourage brand loyalty.

Popular social networking sites include Facebook, 
Instagram, TikTok, WhatsApp, and X.

Figure 11.2
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Figure 11.3: Some popular search engines

Search engines are programs that helps people fi nd the information they are looking for online using 
keywords or phrases. They employ complex algorithms to provide relevant search results based on 
user queries, enabling effi cient information retrieval.

As illustrated in the statistics in Figure 11.4 (www.statcounter.com, April 2024), Google currently 
has the highest share of the search engine market worldwide by a long way, with over 90%.

Figure 11.4

Online shopping, also known as e-commerce, has revolutionised the way many people buy products 
and services. It offers a wide array of items that users can purchase from the comfort of their homes 
via websites and apps. Online shopping provides convenience, extensive product choices, and often 
competitive pricing. It has reshaped the retail industry and consumer habits. Amazon leads the global 
e-commerce market. Its inventory (April 2024) included 12 million items and 350 million third-
party sellers list items. Examples of online shopping sites in Ghana include Jumia Ghana, Shopwice, 
Afrikart, KiKUU, and Superprice.

File Transfer Services including platforms like FTP (File Transfer Protocol) and various fi le-sharing 
services, facilitate the seamless transfer of fi les over the internet. These services are essential for 
businesses and individuals looking to share documents, media and data with others digitally.

Streaming services provide on-demand access to movies, TV shows, music, and more, allowing 
users to enjoy entertainment at their convenience. The rise of streaming has led to changes in how 
many people watch and listen to media, with many traditional cable and radio services adapting to the 
digital streaming trend. Examples of streaming platforms include Netfl ix, Apple TV, Amazon Prime 
Video, and Spotify.

Cloud storage services like Google Drive, Dropbox, and iCloud have transformed data management 
and sharing. Users can store fi les and data in the cloud, making them accessible from anywhere with 
an internet connection.

Online gaming platforms and services, including Steam, Xbox Live, PlayStation Network, and the 
Epic Games Store, offer immersive multiplayer gaming experiences. These platforms bring gamers 
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together from around the world, fostering digital communities, competition, and entertainment. 
Online gaming has evolved into a significant industry, with esports poised to solidify its position as 
one of the most popular and fastest-growing sports in the world.

These are just some services that the internet offers, there are many more. These services have 
transformed our lives, offering convenience and connectivity in various forms. From web browsing 
and email communication to social media, online shopping, and streaming platforms, internet services 
have reshaped how we interact with the digital world.

Some people incorrectly interchange the terms ‘internet’ and ‘world wide web’. They are not the 
same thing. The internet is a global network of networks, while the World Wide Web (WWW) is a 
collection of information accessed via the internet. The internet is infrastructure, while the WWW is a 
service on top of that infrastructure.

Evolution of The Internet
There has been a dramatic growth in the number of internet users since its inception. The number of 
internet users is expected to reach 6.54 billion by 2025, making life easier for people across the globe. 
Sharing information and knowledge has become extremely easy for those that have access to the 
internet. As a result, the number of computer networks that are connected has grown exponentially. 
But how did this global phenomenon come into being?

1.	 It started in the late 1960s as a way for government researchers to share information. The 
Advanced Research Projects Agency Network (ARPANET) was a precursor to the internet 
that allowed regional academic and military computers across the USA to interact with each 
other and share information on a single network via telephone lines. It was funded by the 
U.S. Department of Defense and was mainly intended for communication within government 
agencies and universities. Packet switching was the method used where the computer file to be 
sent is effectively broken up into small segments called ‘packets’ distributed across a network, 
and then reordered back into a single file at their destination. Packet switching is the basis on 
which the internet still works today.

2.	 More networks of computers began to join ARPANET, and the need arose for an agreed set of 
rules for handling data and how it moved through the network. This led to the development 
of TCP/IP (Transmission Control Protocol/Internet Protocol) in the 1970’s. TCP allowed 
computers to speak the same language, and it helped the ARPANET to grow into a global 
interconnected network of networks, an example of ‘internetworking’ - internet for short. IP 
when combined with TCP, helps internet traffic find its destination. Every device connected to 
the internet is given a unique IP number. Known as an IP address, the number can be used to 
find the location of any internet-connected device in the world.

3.	 Email was an unintended consequence of the growth of ARPANET. As the network increased 
in popularity and scope, users quickly realised the potential of the network as a tool for sending 
messages between different ARPANET computers. The first email was sent in 1971.

4.	 An increase in the amount of computers on the network made it difficult to keep track of all 
the different IP addresses. This problem was solved by the introduction of the Domain Name 
System (DNS) in 1983. The DNS is the internet’s equivalent of a phone book and converts hard-
to-remember IP addresses into simple names.

5.	 The World Wide Web (WWW) was invented by British computer scientist Tim Berners-Lee 
while working at CERN (the European Organisation for Nuclear Research) in Switzerland in 
1989 and was opened to the public in 1991. For this invention, Tim Berners-Lee wrote three 
technologies—URL, HTML, and HTTP. They enabled a user-friendly interface for the internet 
that allowed it to enter everyday use.
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6. Some of the other milestones in the evolution of the internet are shown in Figure 11.5.

Figure 11.5

So, the internet emerged in the United States in the 1970s but did not become visible to the general 
public until the early 1990s. Internet usage has steadily and rapidly increased since then. By 2020, 
approximately 4.5 billion people, or more than half of the world’s population, were estimated to 
have had access to the internet. According to Statista (www. Statisa.com), 5.35 billion people use 
the internet worldwide as of 2024, accounting for 66.04% of the global population. With over 1.05 
billion users, China has the highest number of internet users. India and the United States follow with 
729 million and 692 million internet users, respectively. The percentage of the population using the 
internet in Ghana has also been growing rapidly. As of January 2023, Ghana registered approximately 
24.06 million internet users, growing from the 23 million reported in 2022.

Several factors drive the continued growth of internet users in Ghana and elsewhere. These factors 
include the increasing affordability of smartphones and mobile data, and the growing popularity of 
online services such as e-commerce, streaming video, and social media.

Advantages of the internet
The advantages of the internet are many and varied. They include:

1. Getting information super fast. You can search for information and get results in just a few 
seconds. All you have to do is type in what you are looking for, and the search engine will fi nd 
lots of websites that match your search. You can even fi lter the results to fi nd the most relevant 
and up-to-date information.

2. Improved connectivity through email, social media, and video conferencing applications.
3. Enabling many more people to be able to work from home or have a virtual offi ce.
4. With E-commerce websites one can easily buy groceries, clothes, household items, and much 

more from the comfort of their own home.
5. The Internet of Things makes our lives easier and more effi cient. Everyday objects like lights, 

heating and security systems can be connected to the internet. This means you can control them 
remotely without having to do everything manually. For example, you can turn on the lights in 
your house before you even get home using an app on your smartphone.

6. Providing a diverse array of options for leisure and amusement. From streaming movies and TV 
shows on platforms like Netfl ix to gaming communities and social media platforms, the internet 
offers endless opportunities to keep people entertained.
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7.	 Providing a range of education resources and tools. These online courses, videos, tutorials, and 
FAQs. There are also websites where you can ask questions and get answers from experts. It is 
like having a whole library at your fingertips! This ready access to information and training has 
empowered learners across the world.

8.	 Providing a source of income for many people. Nowadays, there are many e-commerce 
businesses which employ people with a range of skills, from web designers to delivery drivers. 
The internet enables freelancers to find work globally, entrepreneurs to start new e-commerce 
businesses, and content creators to monetise their blogs, videos, and social media.

9.	 Online banking services mean that you can manage your financial affairs (e.g. paying someone 
by a bank transfer) from the comfort of your own home.

Disadvantages of the internet
Although the internet has many advantages, it also has a number of disadvantages. These include:

1.	 Time wastage, addiction and distractions:

●	 Most internet users waste a lot of time on social networking and other websites while doing 
nothing productive.

●	 Users become addicted to these online services.
●	 This diverts users from other productive pursuits in their lives. It can also negatively 

impact workplace productivity. Students can get disconnected from their studies, which 
can negatively impact their education.

3.	 Lack of content control:

●	 The vastness of the WWW means there is an abundance of content, both good and bad.
●	 Users may accidentally encounter violent or pornographic material they did not intend to see.
●	 Many unethical and pornographic websites harm the younger generation.

4. 	 Trolls, bullying, and stalkers:

●	 Trolls: These are individuals who intentionally provoke or harass others online. The 
anonymity of the internet often emboldens them.

●	 Cyberbullying: Especially affecting young people, cyberbullying occurs when someone 
uses technology (often via the internet) to intimidate others.

●	 Stalking: With personal information readily available online, stalkers can easily find details 
about individuals.

5. 	 Never disconnecting from work:

●	 While remote work from home is convenient, it blurs the boundaries between work and 
personal life.

●	  Notifications can disrupt leisure time, leading to fatigue and burnout.

6.	 Wrong information
	 Although the WWW is regarded as the primary source of information, some websites include 

inaccurate and worthless information. Sometimes, users can have trouble distinguishing 
between what is correct and what is incorrect material.

7.	 Hacking, identity theft, and crime:

●	 To hack means to illegally break into someone’s computer. The internet can be used 
for hacking.

●	 Hackers exploit vulnerabilities to steal personal information (identity theft).
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●	 Internet fraud continues to grow. This involves the internet being used to offer scam 
advertisements that request advance payments via email, websites, chat rooms, or 
message boards.

●	 Hidden corners of the internet facilitate criminal activities.
●	 Malware is harmful software that damages your data or slows 

down your computer’s performance. It can infect your computer 
using various means such as email and downloading infected 
files from the internet.

8. 	 Health and social impacts:

●	 Excessive internet use can lead to loneliness and social isolation.
●	 Sedentary behaviour (sitting for too long) contributes to health issues like obesity.

How Does the Internet Work
The internet is essentially a vast network of computers connected to each other, allowing them to send 
and receive data. Here is a simplified explanation:

1. 	 Data Transmission: Information is transferred across the internet in small units called 
packets. Each packet contains a portion of the data and a header with information about its origins 
and destination.

2.	 Networking Hardware: Devices like routers and switches direct these packets through the 
network to their destination. The hardware uses specific protocols, which are rules that define how 
data is sent and received. The transmission control protocol (TCP) and the internet protocol (IP) have 
been described earlier. The hypertext transfer protocol is what we use to view web sites through 
a browser – that is what the http at the front of any web address stands for. HTTPS is the secure 
version of HTTP. HTTPS ensures that any data transferred between a website and a the user cannot be 
tampered with or modified by a hacker. HTTPS also ensures that the user accesses the actual website 
and not a fake version.

3.	 Distributed Network: The internet is a distributed network, meaning it is not dependent on 
any individual device/computer. This makes it resilient and scalable, as the network can still function 
even if parts of it go down.

4.	 Connection Types: Digital devices can connect to the internet via various methods, including 
fibre optic cables, Wi-Fi, and cellular networks. These connections translate data into electrical signals 
or light pulses that travel at high speeds.

5. 	 IP Addresses and DNS: Every device on the internet has a unique IP address. The Domain 
Name System (DNS) translates human-friendly domain names (like www.example.com) into IP 
addresses that computers use to connect to each other.
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Figure 11.6

For example, if you type the web address, also called the URl (Uniform Resource Locator), www.
heightslibrary.org into your browser, your browser would ask DNS for the corresponding IP address. 
DNS would return the IP address assigned to the Heights Library’s domain name (151.101.2.159). 
This IP address gives an accurate location of the webs server where the website fi les reside. Your 
browser then connects to that IP address. The browser sends a request to the server, asking it to send 
a copy of the website to the user/client – see Figure 11.7 below.

Figure 11.7

Learning Tasks

Teachers should assess learners during the learning process. Marks can be assigned to 
presentations, contributions during work, research projects and more.

The summative assessment questions below are only to serve as a guide for the teacher when 
creating questions to measure learners’ comprehension of the fi ve focal areas.

Group Activities

Working in small groups, learners work together to complete the following tasks:
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Task 1 – Matching activity
Match a set of images with the correct name/description from a set of names/descriptions. For 
example, the Google logo and the description, ‘a program that helps people find the information 
they are looking for on the internet’.

Task 2 -Timeline
Create a timeline on paper or in Word (timeline templates are available) of the evolution of the 
internet.

Task 3 – Mind maps
Create a mind map for
•	 the advantages of the internet

•	 the disadvantages of the internet

•	 an internet service, for example, streaming media (different group are assigned a different 
service)

Task 4 – Research and share
Research a topic relating to the evolution of the internet, for example, internet protocols. The 
groups are given different topics to research and should report their findings to the whole class.

Task 5 - Glossary
Create a glossary of terms relating to the internet using the Tables tools in Word.

Task 6 – Research and present
Research a person who has made a significant contribution to the development of the internet 
such as Tim Berners-Lee and create a slideshow about this person and their contribution(s).

Task 7 - Poster
Create a poster which illustrates the difference between two internet-related terms, for example, 
the difference between the WWW and the internet, a search engine and a browser, or a web 
address and an IP address.

Pedagogical Exemplars
These examples are only to serve as a guide to the teacher.

Brainstorming and group discussions: Engage in individual and mixed-ability/gender-sensitive 
group work to brainstorm related focal points at appropriate times, for example, the services provided 
by the internet, internet terms, advantages of the internet, disadvantages of the internet. This should 
lead to meaningful discussions and a deeper appreciation of how the internet has evolved over the 
past 55 years.

Direct instruction: The teacher goes through the significant stages in the development of the internet 
using a slideshow with appropriate multimedia (images, video).

Project-Based Learning: Integrate the focal areas into projects where learners can research, create 
presentations, and collaborate with peers, fostering critical thinking and problem-solving skills. 
Examples of projects are included in the Learning Tasks and Key Assessments.

Inquiry-based learning: For example, ask learners to evaluate The Rich Get Richer Hypothesis 
(2002) which proposes that individuals who are highly extroverted or who are more comfortable in 
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social situations would be more likely to use the internet to extend their social networks and enhance 
the quality of their friendships.

Collaborative Learning: Facilitate group work, for example, working together to put cards giving 
milestones in the history of the internet in chronological order. Digital tools, where possible, can be 
used for certain group activities to enable communication and collaboration, such as shared documents 
and discussion forums.

Digital Literacy Skills: Assist learners to effectively and responsibly use digital devices for internet 
research, digital citizenship, and online safety. Discussions about and tasks relating to online safety 
should be included as they are important and are relevant in this section.

Key Assessments
Teachers should assess learners during the learning process. Marks can be assigned to presentations, 
contributions during work, research projects and more.

The summative assessment questions below are only to serve as a guide for the teacher when creating 
questions to measure learners’ comprehension of the five focal areas.

Level 1 (Recall and Reproduction)
1.	 Which of these descriptions best fits the internet?

a. 	 a collection of different websites from around the world
b. 	 a folder on your computer that stores multimedia files
c. 	 a global network of networks of computers and electronic devices

2.	 Identify the key link between the internet and the World Wide Web.
3.	 What is a search engine?
4.	 In which country did the internet start?
5.	 Which of the following is NOT a web browser?

a.	 Firefox
b.	 Safari
c.	 Windows
d. 	 Edge

6.	 Google is an example of

a.	 a browser
b.	 a search engine
c.	 a web page

7.	 An IP address is unique identifier assigned to every building connected to the internet.

a.	 true
b.	 false

8.	 Name two social media platforms.
9.	 In the history of the internet, which protocol was invented first – TCP/IP or HTTP?
10.	 Name a file-sharing service.
11.	 Who invented the WWW?

a.	 Bill Gates
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b.  Sir Tim Berners-Lee
c.  Steve Jobs

12. A relatively recent milestone in the development in the ongoing evolution of the internet is the 
IoT. What does IoT stand for?

13. Complete the sentences:

a.  E_______________ is the trading of goods and services on the internet.
b.  A___________, founded by the U.S. Department of Defence in 1969, is viewed as the 

forerunner of the _______________.
c. Online i____________ __________ is a crime in which an attacker uses fraud or deception 

to obtain personal or sensitive information from a victim and misuses it to act in the 
victim’s name.

d.  E_____________ is an internet service that is a convenient, fast, and economic means of 
exchanging messages.

14.  Users can store fi les and data in data centres, making them accessible from anywhere with an 
internet connection. What is this internet service normally known as?

15.  Which of the following internet milestones happened fi rst?
 Invention of WWW, First email sent, ARPANET founded, Launch of Facebook, TCP/IP fi rst used.
16. Underline the protocol shown in Figure 11.8.

Level 2 (Skills and Concepts)
17.  a. Use Figure 11.8 to explain what is meant by the following:

i. A URL
ii.  A domain name

b. What does the domain suffi x gh indicate?

18. Name and describe two internet services that relate to the entertainment sector.
19. Put these internet milestones in chronological order (earliest to latest):
Invention of WWW, First email sent, ARPANET founded, Launch of Facebook, TCP/IP fi rst used.
20. Describe two advantages and two disadvantages of the internet.
21. How does identity theft cause problems for online users?
22. Describe a main function of a browser program.
23. Explain the difference between the HTTP and the HTTPs protocols
24. Use a word processor to create a poster on online safety for display in your classroom.
25. A relatively recent milestone in the evolution of the internet is the Internet of Things. What is 

the Internet of Things?
26. Analyse the role of the DNS and IP addresses in accessing websites on the WWW.
27. Create a multimedia presentation on the evolution of the internet. You should include at least 

eight signifi cant stages in this evolution and devote one slide per stage.
29.  a. Identify three internet safety issues.

b. Create a list of ten tips for staying safe while using the internet.

30. Explain how data is transmitted over the internet using TCP/IP protocols.

Figure 11.8
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31. Describe two ways that a computer could get infected with a virus from being connected to 
the internet.

32. Google.com was the most visited website in Ghana in February 2024. Figure 11.9 below shows 
the stats (https://www.semrush.com/trending-websites/gh/online-services).

Figure 11.9

a.  Why do you think that this website was the most visited?
b.  Suggest the domain name of the second most visited website in Ghana in February 2024. 

Give a reason for your suggested domain name.
(The answer is youtube.com albeit with much reduced access as shown in Figure 11.10 :(The answer is youtube.com albeit with much reduced access as shown in Figure 11.10 :

Figure 11.10

33.  Which development/invention in the history of the internet since 1985 do you think has had the 
most impact on society? Justify your answer.

Level 3 (Strategic Thinking)
34. Why are internet protocols important?
35. Compare and contrast two different web browsers you have used in terms of layout and features.
36. Evaluate the impact of cybersecurity threats on individuals and organisations using the internet.
37. Develop a digital literacy curriculum to educate students on safe internet practises.

Level 4 (Extended Thinking)
38. Predict how emerging technologies like blockchain technology and quantum computing shape 

the future of the internet.
39. Critique the ethical considerations involved in internet censorship and freedom of speech online.
40. Design a research study to investigate the digital divide and its impact on possible future career 

opportunities.
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Week 12
Learning Indicator:  Describe the evolution of the Internet and identify the Internet Service 
Providers (ISPs) and their functions.

Theme/Focal Areas:
1.  Defi	nition	of	an	ISP	and	examples
2.  Describe the functions of an internet service provider

Defi	nition	of	an	ISP	and	Examples
An Internet Service Provider (ISP) is a company that provides internet access for homes and businesses, 
typically for a fee. There are thousands of these companies throughout the world, the most popular in 
the U.S.A. and China being AT&T and China Telecom respectively. Popular ISPs in Ghana include:

●	 MTN Ghana 

●	 Vodafone Ghana 

●	 Surfl ine 
●	 AirtelTigo 

ISP Functions
These include:

• Provide access to the internet

This is the primary function of an ISP. Connecting directly to the internet would require owning 
and managing the infrastructure and technology necessary for an internet connection, which is not 
feasible for the average user due to the high cost, complexity, and expertise required. For a monthly 
fee, ISPs will provide and maintain this infrastructure and technology.

ISPs offer different connection speeds to cater to various needs. The connection speed and cost of 
the ISP service will be determined by the type of connection. Connection types include dial-up, DSl, 
cable, wireless and fi bre-optic. Your location may restrict your choice of ISP access. For example, 
despite signifi cant advancements in telecommunications technology, there are still many regions in 
the world where geographical challenges and the high cost of infrastructure development make it 
diffi cult for service providers to offer broadband or wireless services. In these areas, dial-up internet, 
even though it is slow and now considered ‘old technology’, becomes the only feasible option for 
connecting to the digital world.
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• Email services

Many ISPs provide an email account with a unique address linked to your internet service account. 
See Figure 12.1 below to see the benefi ts advertised with the MTN email service (April 2024).

Figure 12.1

• Web hosting

Any website is typically made of many fi les, such as images, videos, text, and code, that these need to 
be stored on special computers called web servers. Web hosting is a service that maintains, confi gures, 
and runs physical servers to store these fi les, thus making your website accessible on the internet. 
Web hosting services also provide additional support, such as security and website backup. Website 
hosting fees can vary from one ISP to another, from free (though often limited) space, to charges 
based upon the size and functionality of the website.

• Proxy server

A proxy server is a server that sits between you and the rest of 
the internet, acting as a “proxy” for your traffi c – see Figure 12.2. 
For example, consider a situation where you want to search for 
something on Amazon. Without a proxy server, your computer 
would make a data request directly to Amazon’s servers which 
would send the data back to your computer. When connecting via a 
proxy server, that request is passed through an external server and 
sent to Amazon. From there, the requested information is sent back 
through the proxy and fi nally to your computer. Your IP is replaced 
with the proxy servers, making every online system ‘think’ that you 
are connecting from the server, not your computer.

There are many reasons for using a proxy server, one being to enhance privacy and maintain anonymity 
while browsing the internet.

• Technical support

The ISP’s technical support human staff or chatbots troubleshoot customer problems, diagnosing 
faults related to internet access and resolve the issues over the phone. When you sign up with an 
internet service provider (ISP) they usually send you a modem and a router, nowadays normally a 
modem/router combo, and they will usually replace this equipment at no extra cost if it stops working.

A modem is an essential piece of hardware that allows internet-enabled devices to connect with the 
internet. It works by converting signals from a telephone wire or cable wire into a form that your 
computer can understand and vice versa. A router allows you to connect multiple devices (i.e., laptop, 
desktop, smart TV, printer, etc.) to your home or offi ce internet. A router also acts as a bridge to allow 
the devices to communicate with each other via local networks (using a wired or wireless connection).

Figure 12.2
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Figure 12.3 A Modem/Router combo

ISPs in More Detail
1. 	 Connecting users to the internet

●	 When you subscribe to an ISP you can establish a link between your devices (such as 
computers, smartphones, or tablets) and the internet.

●	 ISPs facilitate this connection by providing access through various technologies, including:
	 Broadband: High-speed connections via cable modems, fibre-optic lines, or DSL.
	 Wireless: Utilising cellular networks or Wi-Fi.
	 Dial-up: Using the public telephone network to provide last-mile connections.
●	 The maximum amount of data transmitted over an internet connection in a given amount of 

time is known as bandwidth. This will vary depending on the type of internet connection.

2. 	 Data transmission

●	 Once connected ISPs act as intermediaries between end users and the internet.
●	 When you send a request to access a website, download content, or perform any online 

activity, your ISP is responsible for transmitting that request to the relevant servers.
●	  Similarly, when data (such as web pages, emails, or files) is sent back to your device, the 

ISP delivers it to you.

3. 	 Services provided by ISPs (some explained in more detail earlier)

●	 Internet access: The primary service—connecting users to the internet.
●	 Internet transit: ISPs interconnect through network access points on the internet backbone, 

allowing data to flow globally.
●	 Domain name registration: Managing domain names (e.g., www.example.com) for websites.
●	 Web hosting: Leasing out computing capacity to host websites.
●	 Colocation: Providing physical space for servers in data centres.
●	 + more

4. 	 Historical Context

●	 The internet (originally ARPANET) began as a network between government research labs 
and universities.

●	 In the late 1980s, commercial use of the internet started, and ISPs emerged.
●	 Dial-up ISPs were common initially, but cable TV companies and telephone carriers later 

offered faster broadband connections.
●	 In 1989, the first commercial ISP was founded. It was called ‘The World’, a slow dial-up. 

Since then, the number of commercial ISPs have increased exponentially.
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5.  Net Neutrality

● Net neutrality is the principle that ISPs should enable access to all content and applications 
regardless of the source, and without favouring or blocking particular products or websites.

● Municipal broadband (i.e. broadband provided by public entities instead of private 
companies) has been suggested as a solution to net neutrality issues.

Figure 12.4

Conclusion
As shown in Figure 12.4 above, ISPs provide the infrastructure and technology outside homes and 
buildings that will enable its customers to access the internet. Within the home a modem and router 
are required for internet access, and an ISP will usually supply its customers with this equipment. The 
ISPs also maintain the infrastructure and deal with customer queries and problems. Other functions of 
the ISPs include providing email, web hosting services, and a proxy server. Without ISPs, you would 
be unable to connect to the internet. These companies therefore make it possible for their customers 
to surf the web, shop online, conduct business, and connect with family and friends – all for a fee. 

Linking to The Internet from Home
Figure 12.5 illustrates the steps and digital devices used to access the internet at home.

Figure 12.5
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How you connect your digital device to the internet will vary a little depending on your connection 
type but the steps are generally straightforward and as follows:

1. 	 Wi-Fi connection (quick to set up and flexible positioning)

Step 1: Ensure your Wi-Fi is turned on. Look for the Wi-Fi icon in your taskbar.
Step 2: Access your device’s settings (the path varies by operating system).
Step 3: Find your Wi-Fi network name (Service Set Identifier or SSID) from the available list.
Step 4: Enter the network password (if required).
Step 5: Wait for your computer to connect to the Wi-Fi network.

2. 	 Ethernet connection (good for stability and speed)

Step 1: Use an Ethernet cable to connect your computer to your router or modem.
Step 2: Make sure your network is up and running.

3. 	 Dial-up connection (slow, an older method and less common nowadays)

Step 1: Plug your modem into the phone jack.
Step 2: Connect the modem to your computer.

Learning Tasks

Teachers should assess learners during the learning process. Marks can be assigned to 
presentations, contributions during work, research projects and more.

The summative assessment questions below are only to serve as a guide for the teacher when 
creating questions to measure learners’ comprehension of the five focal areas.

Task 1 – Research

Learners, either individually or in small groups, should research and create a list of different 
ISPs available in Ghana. They should include information such as the services offered, pricing 
plans, customer reviews, and any unique features of each ISP.

(According to Wikipedia (April 2024), Ghana has over 15 commercial internet service providers 
and the majority of their customers access the internet from mobile devices).

Task 2 – Comparison

Learners, either individually or in small groups, should then compare and contrast two of these 
ISPs based on factors such as speed, reliability, customer service, and pricing. They can create 
a presentation or infographic to showcase their findings.

Task 3 - Case study

Provide learners with a case study of a real-life scenario relating to a involving an ISP and ask 
them to analyse the situation. Learners can discuss the challenges faced by the ISP, potential 
solutions, and the impact on customers.

Task 4 – Policy analysis

Learners should research and analyse current policies and regulations related to ISPs in Ghana. 
They should explore the implications of these policies on competition, consumer rights, and 
privacy. A word-processed report should be created for this task.
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Task 5 – Customer service role play

Direct learners in a role-play of a scenario between an ISP representative and a customer/
potential customer. They can practise common scenarios such as enquiring about a new service 
plan, setting up a new connection, troubleshooting technical issues, or upgrading a plan.

Task 6 - Industry trends

Assign learners a current or emerging ISP-related topics to research and present. Topics could 
include the rollout of 5G technology, the impact of net neutrality regulations, and the growth of 
fibre-optic networks.

Task 7 - Ethics discussion

Facilitate a class discussion on ethical considerations related to ISPs, such as data privacy, 
net neutrality, and fair competition. Encourage learners to share their perspectives and debate 
different viewpoints.

Task 8 - Hands-on activity

The learners could conduct a Ping test on the school internet connection at the following site or 
similar: https://www.bandwidthplace.com/ping-test.

Task 9 - Business model

Challenge learners to develop a business plan for a new ISP startup. They can outline the 
target market, pricing strategy, marketing tactics, and competitive advantage of their proposed 
business.

Task 10 - Research and present

Have learners prepare a presentation on the history of ISPs, including key milestones, 
technological advancements, and the evolution of internet connectivity over time.

Task 11 - Glossary

Add to your Internet Glossary created in Week 11 with additional terms encountered this week, 
such as ISP, bandwidth, and broadband.

Pedagogical Exemplars
These examples are only to serve as a guide to the teacher.

Project-Based Learning: Integrate the focal areas into projects where learners can research, create 
presentations, and collaborate with peers, fostering critical thinking and problem-solving skills. 
Examples of projects are included in the Learning Tasks and Key Assessments.

Collaborative Learning: Facilitate group work, for example, working together to put cards giving 
milestones in the history of the internet in chronological order. Digital tools, where possible, can be 
used for certain group activities to enable communication and collaboration, such as shared documents 
and discussion forums.

Digital Literacy Skills: Assist learners to effectively and responsibly use digital devices for internet 
research, digital citizenship, and online safety. Learners will have many opportunities to use the 
practical skills they have developed in this course to date (Word, PowerPoint, and using the internet).

Teacher Demonstration: Show learners how to do internet searches more effectively (if this has 
not been done earlier in the course). There are may guides and tips available on the internet such as: 
https://www.freecodecamp.org/news/how-to-google-like-a-pro-10-tips-for-effective-googling/
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Key Assessments
Teachers should assess learners during the learning process. Marks can be assigned to presentations, 
contributions during work, research projects and more.

The summative assessment questions below are only to serve as a guide for the teacher when creating 
questions to measure learners’ comprehension of the five focal areas.

DOK Level 1 (Recall and Reproduction)
1.	 What does an ISP stand for?
2.	 Identify the primary service provided by an internet service provider?
3.	 List the names of ISPs operating in Ghana.
4.	 Complete the following description:
	 To connect to the internet the following are needed:

•	 a computer
•	 __________________________
•	 modem and/or router
•	 an ISP
•	 a web browser e.g. Chrome, Safari

5. 	 What is a router used for in computing?

a.	 Processing sound
b.	 Providing power to the computer
c.	 Connecting several devices to a single internet connection
d.	 Creating driving directions for Google Maps

6.	 Complete this sentence:
	 The maximum amount of data transmitted over an internet connection in a given amount of 

time is known as _____________________.
7.	 State the name of one other function of an ISP other than providing internet access to individuals 

and organisations.
8.	 Broadband is the transmission of high-quality data of wide bandwidth.

a.	 true
b.	 false

DOK Level 2 (Skills and Concepts)
9.	 Explain why without an ISP we would be unable to connect to the internet.
10.	 Describe three services provided by ISPs.
11.	 Describe the different technologies (such DSL, cable, fibre) that ISPs use connects users to 

the internet.
12.	 Describe the relative advantages and disadvantages of following types of internet connections: 

cable broadband, fibre optic broadband, and Wi-Fi broadband.
	 Present your work in a Word table.
13.	 Analyse customer reviews to evaluate the quality of service provided by a specific ISP.
14.	 Outline the steps needed to connect a smartphone to a home Wi-Fi network.
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DOK Level 3 (Strategic Thinking)
15.	 Evaluate the impact of net neutrality regulations on ISPs and internet users.
16.	 Develop a plan to improve customer service and satisfaction for an ISP facing negative feedback.
17.	 Create a proposal for a new pricing plan or service offering to attract more customers to an ISP.

DOK Level 4 (Extended Thinking)
18.	 Predict how emerging technologies such as 5G or satellite internet will impact the traditional 

business model of ISPs.
19.	 Critique the ethical implications of ISPs collecting and monetising user data without consent.
20.	 Design a comprehensive policy framework to regulate ISPs and ensure fair competition in 

the market.

Section Review
Since its inception in 1969, the internet has developed to be a transformative force in everyday 
life across all sectors of society. By the end of this section, learner should have developed an 
understanding of the evolution of the internet from studying the key milestones in its history 
and exploring some of the main services it now provides. They should also have developed 
an appreciation and understanding of its main components, in particular the role of an ISP in 
enabling them to use the internet - for schoolwork, entertainment or whatever. The teacher will 
have guided discussions on the advantages and disadvantages of the internet. This will have 
provided an opening to discuss the important issue of online safety.

Through a study of the topics in this section, learners should also have developed an awareness 
of how current and some emerging IT technologies may impact the shape of the internet in the 
future. Guided instruction on making effective searches using search engines will assist learners 
when completing future internet research tasks. The suggested activities in the manual have a 
strong focus on critical thinking, problem-solving, and teamwork which are three important 
life skills.
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